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This manual is for electronic distribution mainly. 

If you have it on paper and you no longer need it, please, recycle it! 

 

 

The latest versions of our User's Manuals are available at 

www.acom-bg.com 

 

http://www.acom-bg.com/


User's Manual | ACOM 700S | 1.8-54 MHz Linear Amplifier  

April 2024 S e c t i o n  ABOUT DOCUMENTATION | Page 3 of 92 

 

ABOUT DOCUMENTATION 
 

 

All ACOM documentation (including manuals, brochures, specifications, descriptions, presentations, video 

materials, etc.) are based on the latest available information at the time of creation of our documents. 

 

As we always strive to constantly improve and update our products, ALL PRODUCTS, PRODUCT 

SPECIFICATIONS AND DATA ARE SUBJECT TO CHANGE. ACOM reserves the right to make changes and 

improvements at any time without further notice or obligation to notify any person or organization of such 

revisions or changes, made in order to improve the reliability, function, quality and design, and/or 

performance of the ACOM products and services. 

 

Further, this User's Manual is provided AS IS and ACOM shall not be liable for possible errors contained 

herein. 

 

ACOM company creates and distributes its documentation in ENGLISH language only. 

Any translations in other languages made by our dealers, partners, distributors, etc. 

cannot be related to ACOM company in any way. 

ACOM is not liable for non-English documentation correctness in any way. 

 

 

The cover images used in the manual are illustrative only. 

 

 

We are continuously striving to improve our documentation, but nobody is perfect. 

And our documentation is not an exception of this rule. 

Have you found any errors or would you like to suggest changes in our documentation? 

Please help us by sending your suggestions to the following e-mail address: 

documentation@acom-bg.com 

 

 

The latest versions of our User's Manuals are available at 

www.acom-bg.com 

 

 

 

We highly recommend you to use this manual in electronic form as PDF-file instead of printed version. The 

PDF-file is easy to read on any computer, tablet, smart phone or other similar device. In the PDF file you will 

find the necessary information very fast due to context-oriented links (marked in orange) inside the file, 

including context-linked Table of Content. 

To open PDF-files you can use any free PDF viewer, for example: 

• Adobe Acrobat Reader DC (https://get.adobe.com/reader); 

• Foxit Reader (https://www.foxitsoftware.com/pdf-reader); 

• Your web browser. Web browsers like Google Chrome, Firefox, and Safari all have integrated 

PDF readers. 

 

mailto:documentation@acom-bg.com?subject=ACOM%20Documentation
http://www.acom-bg.com/
https://get.adobe.com/reader
https://www.foxitsoftware.com/pdf-reader
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Title of Documentation ACOM 700S 1.8-54 MHz Linear Amplifier 

User's Manual 

Installation, Operation and Maintenance 

Type of Documentation User's Manual 

Purpose of Documentation This manual explains Installation, Operation and Maintenance of the 

ACOM 700S 1.8-54 MHz Linear Amplifier. 

Record of Revisions Description Release Date Notes 

 ACOM 700S User's Manual 12.2017 First edition 

 ACOM 700S User's Manual - Second edition 

 ACOM 700S User's Manual 17.12.2019 Third edition 

 ACOM 700S User's Manual 31.05.2021 Fourth edition, R01 

 ACOM 700S User's Manual 02.04.2024 Fourth edition, R02 

    

Validity The specified data is for product description purposes only and may not be 

deemed to be guaranteed unless expressly confirmed in the contract. All 

rights are reserved with respect to the content of this manual and the 

availability of the product. 

Copyrights © 2024 ACOM Ltd. 

Copying this document, giving it to others and the use or communication 

of the contents thereof without express authority, are forbidden. 

Offenders will be held liable for infringement of any intellectual property 

of ACOM Ltd. and all damages which may rise as a result.  

Trademarks ICOM, KENWOOD, YAESU, ELECRAFT, and other product names or brands 

mentioned in this documentation are either registered trademarks or 

trademarks of their respective holders.  

Published by ACOM Ltd. 

Bulgaria  |  Bozhurishte 2227 

Sofia-Bozhurishte Industrial Park  |  6 Valeri Petrov Str. 

GPS coordinates:  42.748616о  |  23.209801о 

Web: www.acom-bg.com 

E-mail: documentation@acom-bg.com 

Note This manual has been printed on chlorine-free bleached paper. 

 

 

 

 

http://www.acom-bg.com/
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1. GENERAL INFORMATION 
 

Congratulations on purchasing one of the finest solid-state 1.8-54 MHz linear amplifiers in the world today. 

ACOM is pleased that you have chosen one of our products, and we will endeavor to provide you with the 

information and support you need to enjoy your purchase for many years. 

We urge you to read all of the following materials before you embark on operating your new amplifier. 
 

 

1.1. Introduction and Description 

 

This manual explains: 

• Installation 

• Operation and 

• Maintenance 

of the ACOM 700S 1.8-54 MHz solid-state linear power amplifier. 

 

The ACOM 700S is a state-of-the art linear power amplifier that covers all amateur bands from 1.8 through 

54 MHz and provides 700 W rated output power (PEP or continuous carrier). The amplifier operating 

information is shown on a multi-functional, high resolution color display. ACOM 700S can be controlled 

either by the six front-panel buttons or remotely. 
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1.2. To the Reader of this Manual 

 

This document is written for the technically qualified users who will use the ACOM amplifier. 

 

To ensure your safety in accordance with safety and security standards, read this manual carefully and 

follow the steps described in it. 

 

Everyone who will use the amplifier must read this manual, and follow the instructions in it, and other 

accompanying ACOM documentation (see Section 1.5 Additional Documentation), and consider also the 

appropriate safety precautions. 

 

 

Informational notes 

 

Observe the informational notes provided in this manual to ensure reliable and efficient operation of the 

amplifier. In this manual, you will find the following informational notes: 

 

 

The information symbol highlights operating procedures or practices that may improve 

equipment reliability and/or personnel performance, or to emphasize a concept. 
 

 

The book symbol represents a cross reference to external documentation, e.g., other 

ACOM manual. 
 

 

Symbols and fonts used for marking text 

 

In this manual the following symbols and fonts are used for marking text: 

 

Format Meaning 

Orange bold text 

 

Identifies all internal links in the document between Sections, Figures, 

Tables, etc. for your convenience. 

BOLD TEXT IN 

CAPITAL LETTERS 

Identifies the connectors, switches, and button names and labels. 

TEXT IN CAPITAL 

LETTERS 

Identifies the amplifier operating modes, menu names, messages, etc. 
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1.3. Product Features 

 

• Easy to operate 

The overall operation of ACOM 700S is extremely simplified: the screen menus are intuitive and easy 

to follow, no special skill is required from the operator when changing frequency bands. 

• User-friendly automatic control 

When connected to a transceiver with CAT capability, the amplifier will track the operating frequency, 

and will change bands accordingly. 

Even if not CAT connected, the amplifier monitors the input signal frequency through the built-in 

frequency counter and automatically switches bands. 

• High resolution color display 

All amplifier status indications are explained via detailed text displayed on the 5" high resolution color 

display (108x65 mm, 800x480 pixels, and 24-bit color). 

• Transceiver-independent 

Compatible with all transceiver models available on the market - does not need any special signals: 

"ground on transmit" and less than 40 W of RF drive power is sufficient. 

• LDMOS transistor technology 

The ACOM 700S amplifier uses a rugged LDMOS transistor. 

• Broadband input circuit 

Broadband input circuit, providing a perfect transceiver load with SWR below 1.2:1 (typically 1.1:1), 

without retuning throughout the whole frequency range from 1.8 to 54 MHz. 

• Intelligence 

Takes care of itself via continuously working protection circuits in all modes. 

The operator can monitor numerically more than 10 parameters of the amplifier in operation. 

• Remote control capabilities 

Controlled remotely via the Internet by the ACOM eBox Ethernet Remote Control device (optional 

equipment) and through an RS-232 port. 

• Easy maintenance 

Detailed data (55 parameters) about each of the last 28 hard-fault protection trips is stored in the 

amplifier's non-volatile memory. 

• Compact and lightweight construction 

Convenient for expeditions and field operation due to the extremely compact and lightweight 

construction and the built-in switching-mode power supply (SMPS). SMPS operates with extended 

mains voltage range of 100-240 VAC, with no internal switch over. The consumed current is purely 

sinusoidal, Power Factor Corrected (PFC) and inrush limited. This makes the operation from unstable 

mains and generators easy and trouble-free. 

• Electromagnetic compatibility 

Perfect electromagnetic compatibility (EMC) with both highly sensitive devices and the powerful 

devices in the radio station (receivers, computers, other amplifiers) exceeding the standard EMC 

requirements due to the used PFC and built-in radio-frequency filters. 
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1.4. Product History and Documentation Validity 

 

The ACOM 700S solid-state power amplifier serial production started in March 2018. The production has 

continued to these days without functional changes and with hardware improvements only. 

 

This manual refers to the ACOM 700S amplifier and describes the operating possibilities of all amplifiers 

produced till the publishing date of this manual. 

 

This manual is valid till a new manual is issued. 

 

Table 1-1 | Production versions history 

Production Version 

Release Date 
Notes 

03.2018 Basic design; 

  

  

  

 

Table 1-1 | Production versions history 

 

 

1.5. Additional Documentation 

 

For further important information, please, refer to the following documentation: 

 

 • ACOM 700S Brochure; 

 • ACOM CAT cables Technical Information; 

 • ACOM 04AT User's Manual; 

 • ACOM 06AT User's Manual; 

 • ACOM eBox User's Manual. 

The documentation is available for download at www.acom-bg.com. 

 

 

1.6. Product Identification 

 

Every ACOM product features an ID (identification) label/plate. On this label, you can find data identifying 

the device. Which product identification data are important? 

• Model designation - The model designation is the name of the device; 

• Serial Number - Most products have their own serial number. The serial number is a 

consecutive number for unique identification of products with the same model designation. 

It serves to ensure traceability of a product after it has been put in circulation, e.g., to find 

the date of invoice that is required to determine guarantee and warranty periods. The term 

serial number is mostly abbreviated to SN or S/N. 

 

http://www.acom-bg.com/
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Figure 1-1 | ID (identification) label/plate, example 

 
Figure 1-1 | ID (identification) label/plate, example 

 

 

The serial number can be seen in the menu FAULTS LOG too. 

 

 

1.7. Equipment Supplied 

 

The ACOM 700S amplifier is shipped as package, consisting of: 

 

Table 1-2 | Package contents 

Nr. PACKAGE CONTENTS Pcs. 

1 Amplifier ACOM 700S 1 

2 Quality Inspection Certificate (hard copy) 1 

 

Table 1-2 | Package contents 

 

 

The User's Manual is available as PDF-file only. 

The latest version of the User's Manual is available at www.acom-bg.com. 

 

 

 

http://www.acom-bg.com/
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1.8. Optional Equipment 

 

There are several individual purchase options available. They are: 

 

Table 1-3 | Optional equipment 

Nr. OPTIONAL EQUIPMENT 

1 ACOM 06AT | Automatic Antenna Tuner and Switch 

2 ACOM 04AT | Remote Automatic Antenna Tuner and Switch 

3 ACOM eBox | | Ethernet Remote Control Device 

 

Table 1-3 | Optional equipment 

 

 

The ACOM 04AT and 06AT automatic antenna tuners with four-way antenna switches are 

designed to work with our transistor (solid-state) amplifier series, including the ACOM 

700S (see Section 4.3 Operation with an External Antenna Tuner). 

Using the ACOM 06AT or 04AT with an ACOM 700S amplifier is highly recommended.   

 

Figure 1-2 | ACOM 06AT automatic antenna tuner and switch (shown near 700S amplifier) 

 
Figure 1-2 | ACOM 06AT automatic antenna tuner and switch (shown near 700S amplifier)  

 

 

Figure 1-3 | ACOM 04AT remote automatic antenna tuner and switch 

    

Wall mounted tuner Mast mounted tuner Desk mounted tuner 

 

Figure 1-3 | ACOM 04AT remote automatic antenna tuner and switch 
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Remote control of ACOM 700S is provided by ACOM eBox Ethernet remote control device 

(see Section 6 REMOTE CONTROL). 

 

Figure 1-4 | ACOM eBox Ethernet Remote Control device 

 
Figure 1-4 | ACOM eBox Ethernet Remote Control device 

 

 

1.9. Owner Assistance 

 

If assistance is needed, you should contact your local dealer first. If necessary, your dealer will contact ACOM 

for additional guidance. 

 

If you still have an issue you need to discuss with one of ACOM's specialists, the contact information is as 

follows: 

ACOM Ltd. 

Web-site: www.acom-bg.com -> Support page 

E-mail: support@acom-bg.com 

Bulgaria  |  Bozhurishte 2227 

Sofia-Bozhurishte Industrial Park  |  6 Valeri Petrov Str. 

GPS coordinates:  42.748616о  |  23.209801о 
 

 

Including the ACOM equipment's model name, serial number, and a detailed problem 

description in your service assistance request is mandatory. Without this information, 

we cannot proceed with your request, or the proceeding will take longer. 
 

 

http://https/www.acom-bg.com/support/technical-support
mailto:support@acom-bg.com?subject=ACOM%20Support
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1.10. Safety Considerations, Explicit Definitions 

 

The ACOM 700S linear amplifier is a Safety Class I unit regarding protection against electric shock. The third 

grounding lead of its mains cord (which is colored yellow with two green stripes) and the ground stud on 

the rear panel of the amplifier (marked GND, see Figure 2-4 | Rear panel - Connections, Pos. (a)) must be 

connected to the station's grounding system for safe operation. 

 

The amplifier is designed to meet international safety standards and complies with CE safety and 

electromagnetic compatibility requirements, as well as FCC regulations. 

 

This User's Manual contains information, warnings (signal words Danger, Warning, Caution and Notice) 

and instructions, related to hazards, that should be followed by the user in order to ensure safe operation 

and to keep the amplifier in a safe working condition at all times. 

 

 

The safety instructions contained in this User's Manual feature specific signal words 

(Danger, Warning, Caution and Notice) and, where required, a safety alert symbol, in 

accordance with actual standards ISO 3864 or ANSI Z535. 

 

 

The EXPLICIT DEFINITIONS described below apply to this User's Manual: 

 

 DANGER 

These notes call attention to a procedure or instructions which, if not correctly 

performed, will result in serious personal injuries and even death.  

 

 

 WARNING 

These notes call attention to a procedure or instructions which, if not correctly 

performed, could result in serious personal injuries and even death. 

 

 

 CAUTION 

These notes call attention to a procedure or instructions which, if not correctly 

performed, could result in minor or moderate personal injuries. 

 

 

NOTICE 

These notes call attention to a procedure or instructions which, if not correctly 

performed, could result in property damage or equipment damage not exclusively to 

the amplifier but also to connected equipment. 
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PRECAUTIONS: 
 

 

 DANGER 

For safe operation, the amplifier's grounding stud on the rear panel (marked GND, see 

Figure 2-4 | Rear panel - Connections) should be connected according to the applicable 

standards and local regulations for electric safety, fire safety and lightning protection, in 

all cases when the radio station is equipped with outdoor antenna(s)! 

 

 

 DANGER 

NEVER underestimate the danger of lightning! 

To prevent accidents, connection/disconnection to the grounding and antennas should 

only be carried out in clear, quiet, and sunny weather when there is no danger of 

lightning and static discharges. 

 

 

 DANGER 

Both the mains voltage and the high DC voltage up to 500 V inside the ACOM 700S 

amplifier are LETHAL! 

For your safety, pull the amplifier power plug out of the mains wall outlet and WAIT AT 

LEAST 3 minutes EACH TIME BEFORE you remove the cover of the amplifier. 

 

 

 DANGER 

Never allow anyone, ESPECIALLY CHILDREN, to push or put anything into holes in the 

case - this will cause electric shock. NEVER TOUCH AN ANTENNA or antenna insulators 

during transmission or tuning - this may result in an electric shock or burn. NEVER 

EXPOSE the amplifier to rain, snow, or any liquids. AVOID placing the amplifier in 

excessively dusty environments or in direct sunlight. DO NOT OBSTRUCT COOLING ducts 

or vents. Keep a minimum clearance distance of 10 cm (4 inches) to any other devices or 

objects. 

 

 

 WARNING 

To avoid damage (not covered under warranty) read the Section 2 INSTALLATION of this 

User's Manual carefully. Installation of the equipment must comply with local and 

national electrical codes. 

If you have any doubts about the installation, operation, or safety of the amplifier, 

please, consult your dealer. 
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 WARNING 

NEVER operate the equipment if you notice an abnormal odor, sound, or smoke. 

Immediately turn off the power and contact your dealer for assistance (see Section 

1.9 Owner Assistance). 

 

 

 WARNING 

Do not undertake on your own repairs or changes in hardware or software of the 

amplifier in order not to endanger your or other's health and life and not to damage the 

amplifier and the equipment connected with it, not covered by warranty. The 

manufacturer is not liable for another's actions and responsibility shall be assumed by 

the doer. 

 

 

 WARNING 

To be in compliance with the RF exposure requirements, please, read Section 

8.3.c) RF Exposure Information. 
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2. INSTALLATION 
 

2.1. Unpacking and Initial Inspection 
 

 

Before you install your amplifier, thoroughly read this manual. 

First, carefully inspect the cardboard carton and its contents for physical damage. 

ACOM ships amplifiers in highly protected containers, but it cannot assure that 

mistreatment by shippers will not occur. If damage is evident, notify your dealer 

immediately. Delay may void the carrier's warranty. 
 

 

 CAUTION 

The packaged weight is about 16 kg and is recommended to be handled by two persons. 

 

 

Keep all packing materials for possible future antenna tuner shipment (see Section 8.4.4 

Returning to the Service Provider). 

 

Figure 2-1 | Packaging carton (outside view) 

 
Figure 2-1 | Packaging carton (outside view) 

 

 

Unpack the amplifier as described below: 

• Open the cardboard carton (see Figure 2-1 | Packaging carton (outside view) and 

Figure 2-2 | ACOM 700S packaged in a cardboard box, Pos. 1); 

• Take out the top secure element 

(see Figure 2-2 | ACOM 700S packaged in a cardboard box, Pos. 2); 

• Open the internal cardboard carton 

(see Figure 2-2 | ACOM 700S packaged in a cardboard box, Pos. 3); 
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• Take out the amplifier using handles of the middle secure element 

(see Figure 2-2 | ACOM 700S packaged in a cardboard box, Pos. 4); 

• Take out the amplifier (Pos. 8) from the middle secure element and remove top, bottom, and 

sides flat secure elements 

(see Figure 2-2 | ACOM 700S packaged in a cardboard box, Pos. 5, 6 and 7); 

• Now, the amplifier is ready for installation. 

 

Figure 2-2 | ACOM 700S packaged in a cardboard box 

 
 

Figure 2-2 | ACOM 700S packaged in a cardboard box 

 

 

It is not necessary to take out the bottom secure element. 

(see Figure 2-2 | ACOM 700S packaged in a cardboard box, Pos. 9) 

1 

3 

4 

5 

6 

2 

 

8 

9 

7 
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2.2. Amplifier Location Selection 

 

 

 CAUTION 

The unit's weight is about 12 kg, which should preferably be handled by two persons. 

 

 

Position the amplifier near the place where it will be used. You will need an easy access to the command 

knobs and indicator's area, as well as to the rear panel cabling. 

 

 

NOTICE 

The ACOM 700S is forced air cooled. Keep a minimum clearance distance of 10 cm 

(4 inches) to any other devices or objects. 

 

 

The exhaust air can reach 65 oC (150 oF) and if the surrounding devices are sensitive to heating from outside 

or use forced air cooling themselves, increase the distances accordingly. 

 

Figure 2-3 | Front panel - Ergonomic position with tilt foot bar 

 
Figure 2-3 | Front panel - Ergonomic position with tilt foot bar 

 

 

NOTICE 

Do not leave accidental paper, cloth, or other lightweight pieces around and under the 

amplifier. They may be drawn in by the cooling air stream and block the vents. This will 

lead to overheating and accelerated material aging, not covered by the warranty. 
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2.3. Line Voltage Selection 
 

The ACOM 700S amplifier is supplied with built-in switching-mode power supply (SMPS). 

 

The amplifier operates in an extended mains voltage range of 100-240 VAC, with no internal switch over. 

The consumed current is purely sinusoidal, Power Factor Corrected (PFC) and inrush limited. This makes the 

operation from unstable mains and generators easy and trouble free. 

 

 

Thanks to the built-in SMPS, the ACOM 700S has no mains line voltage selector to take 

care of! 

 

 

See Section 7.3 Fuse Replacement for correct fuse rating. 

 

 

 

2.4. Connections 
 

Please, see Figure 2-4 | Rear panel - Connections. 

Connection to your station must be accomplished in the order described below, before you apply mains 

voltage to the amplifier. 

 

 WARNING 

Installation of the equipment must comply with local and national electrical codes. 

The applicable standards and local regulations shall prevail if there is a difference in the 

requirements, and if they contain more or stricter requirements than the minimum for 

installation stated in our documentation. 

 

Figure 2-4 | Rear panel - Connections 

 
Figure 2-4 | Rear panel - Connections 

d) 

a) 

e) 

1 

f) g) 2 

3 

4 

c) b) 
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a) GND stud for grounding 

 

Before you connect the amplifier to external grounding, you should advise with a 

licensed electrician and confirm such kind of connection is allowed by your national 

standards and regulations for electric safety, fire safety, and lightning protection. 

Simultaneous connection to the earth grounding and protective earth may be 

inadmissible or may fall under special requirements in some countries! 

 

 

 DANGER 

Never use the gas installation pipes for grounding. This can cause an EXPLOSION! 

 

 

 DANGER 

Do not use the steam-heating or water-supply network pipes for grounding! You may 

expose to dangerous voltage not only yourself but also other people using the same 

installation. 

 

 

 WARNING 

This amplifier needs to be grounded.  

When installing or replacing the unit, the ground connection must always be made first 

and disconnected last. 

Note that the grounding system may have to withstand currents over 15 A with 

insignificant voltage drop on it. Therefore, it may be necessary to improve it 

considerably, i.e., to become less resistive, with heavier leads and lower-resistive ground 

path. 

Use a green and yellow ground wire to connect the wing-nut grounding stud of the 

amplifier (on the rear panel, marked GND) to the station's grounding system. 

(See Figure 2-4 | Rear panel - Connections, Pos. (a)) 

The grounding leads should be at least 4 mm² (AWG 11 or SWG 13). 

 

 

If no other data is available, in order to avoid conduction of a lightning strike with all 

resulting consequences - death, injury, fire, equipment damage, destruction, etc., please, 

read and understand clearly: 

 • ACOM 03AT User's Manual 

Pay particular attention to Sections 2-3 Remote Unit Installation in the downloaded manual; 

 • ACOM 04AT User's Manual 

Pay particular attention to Appendix 1 – Lightning Protection in the downloaded manual. 

The documentation is available for download at www.acom-bg.com. 

 

http://www.acom-bg.com/
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For details and recommendations on the grounding and RF counterpoise system concerning the 

electromagnetic compatibility see also Section 3.6.f) Elimination of electromagnetic compatibility (EMC) 

problems. 

 

b) KEY IN connector 

This is the amplifier's input for receive/transmit control from the transceiver. 

 

The transceiver switches the amplifier from receive mode into transmit mode (RX/TX) by grounding of the 

KEY IN input. 

Run a shielded cable from the "ground on transmit" connector or terminal on your transceiver to the 

amplifier rear panel KEY IN connector (see Figure 2-4 | Rear panel - Connections, Pos. (b)). The KEY IN 

connector uses a standard RCA phono plug. 

 

 

The switching voltage presented from amplifier KEY IN connector to the transceiver 

"ground on transmit" output does not exceed 12 V (positive to the ground). The closed-

circuit is below 6 mA (see Section 8.2.a) Receive / transmit control). 
 

 

Your amplifier will NOT WORK if KEY IN input is not connected properly. 

Transceiver producers give different names to this output and they are for instance 

TX-GND, SEND, T/R-LINE, PTT, etc. Some transceivers require that "ground on transmit" 

is implemented via a software command, or by changing the setting of a switch on the 

rear panel, or interior of the transceiver. Check your transceiver's manual. 

 

 

c) KEY OUT connector 

This is the amplifier's transmit-enabling control output from amplifier to the transceiver. 

 

The KEY OUT connector provides an extra control signal from the amplifier to the transceiver. It can be 

used for improving the receive/transmit (RX/TX) switching safety. 

 

 

NOTICE 

KEY OUT is a low-power open-drain output, make sure that the signal voltage coming 

from the respective transceiver connection does not exceed 50 VDC (open circuit) and 

the closed-circuit current is below 20 mA. 

 

 

If your transceiver has a suitable input that disables transmission unless grounded externally, we 

recommend that you connect it with a shielded cable terminated in a Phono (RCA) connector to the 

KEY OUT connector (see Figure 2-4 | Rear panel - Connections, Pos. (c)) of the amplifier. 
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ACOM 700S will operate normally with KEY OUT unconnected if your transceiver has no 

such input. 

Transceiver producers give different names to this input and they are for instance 

TX-INHIBIT, MUTE, LINEAR, etc. Check your transceiver's manual. 

 

 

d) RF INPUT connector 

Connect a suitable coaxial cable from the transceiver output to the amplifier RF INPUT SO-239 connector 
(see Figure 2-4 | Rear panel - Connections, Pos. (d)), using PL-259 plug. 

 

 

NOTICE 

In order to avoid a damage, turn off your transceiver's internal antenna tuner. 

 

 

e) RF OUTPUT connector 

 

NOTICE 

If this is the first time you will use a power amplifier in your station, pay attention to the 

coaxial cable type from the amplifier's output to the antenna. It must handle the 

increased power safely, particularly on the 10- and 6 meters bands. We recommend that 

you use RG213 cable or better. Check the same for the antenna switch and tuner, as 

well as the whole antenna system (especially multi-band trap antennas). 
 

 

Connect a suitable coaxial cable with a PL-259 plug from the RF OUTPUT (see Figure 2-4 | Rear panel - 

Connections, Pos. (e)) to the antenna switch or tuner, or to antenna for the respective frequency band. 

 

 

The ACOM 04AT and 06AT automatic antenna tuners with four-way antenna switches are 

designed to work with our transistor (solid-state) amplifier series, including the ACOM 

700S (see Section 4.3 Operation with an External Antenna Tuner). 

Using the ACOM 06AT or 04AT with an ACOM 700S amplifier is highly recommended.   

  

 

We recommend coordinating, with ACOM, the use of non-ACOM antenna tuners for 

connection to RF OUTPUT. 

ACOM, as an Original Equipment Manufacturer, keeps the right to refuse the guarantee 

claims if non-suitable equipment is used. 
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f) Main fuses 

Please, see Figure 2-4 | Rear panel - Connections, Pos. (f). 

 

 

NOTICE 

Make sure you check whether the main fuses installed in your amplifier correspond to 

your local mains nominal voltage. If occasion should require replacement of the mains 

fuses, replace them as described in Section 7.3 Fuse Replacement! 

 

 

g) Power cord 

Please, see Figure 2-4 | Rear panel - Connections, Pos. (g). 

Due to the different standards in different countries, the mains plug for the amplifier power supply cable is 

supplied and mounted by the dealer. He connects to the mains cord end a standard mains supply plug 

which meets the Safety Class I unit standard in your country. 

The ground lead of the amplifier's power cord is colored yellow with two green stripes and the blue and 

brown leads are active. When the amplifier is to be used with only one mains fuse, it is connected in series 

with the brown lead, which must be the active. 

 

Table 2-1 | Power cord connections 

 
 

ACOM 

amplifier 

Wire name Description Colors 

N Neutral Blue 

L Line, Active, Live Brown 

G or PE or E Ground (Protective Earthing conductor) Yellow - Green 

 

Table 2-1 | Power cord connections 

 

If you have any doubts about the correct way of connecting the wires, consult your dealer. 
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h) Preparation of wall outlet 

 

 

 WARNING 

Before connecting the amplifier to your mains supply using a licensed electrician, check 

that the supply is correctly wired, and is adequate for the current drawn by the amplifier 

(up to 10 A from 200/240 VAC mains and up to 16 A from 100/120 VAC mains). Make 

certain that the grounding lead is connected properly and that it has a cross section not 

less than the cross section of the phase conductor in the wall outlet for the amplifier. 

 

 

It is preferable that you use the wall outlet closest to the source. The installation leads should be at least 

1.5 mm² (AWG 15 or SWG 17) at operating 200-240 VAC and 2.5 mm² (AWG 13 or SWG 15) at 100-120 VAC 

(recommended values if there are no stricter requirements by your local standard). 

 

Check that the panel fuse has a free capacity for the additional load from the amplifier as specified in 

Section Specifications 8.1.h) Mains Power Consumption at Full Output Power. If you connect the amplifier to a 

different mains outlet, be sure that you check it, too. 

 

 

2.5. Connecting to External Devices (transceiver, computer, etc.) and User Settings 

 

a) CAT/AUX interface connector 

Please, see Figure 2-4 | Rear panel - Connections, Pos. (3). 

CAT/AUX interface is used for connecting and operating with various transceiver models (see Table 2-2 | 

Signals and pin out of the CAT/AUX connector below and the respective menu in Section 5.3 Menu CAT/AUX 

SETTINGS (Selection of CAT/AUX interface), Table 5-1 | Transceiver interface, and Figure 5-4 | Menu CAT/AUX 

SETTINGS). 

 

Most of the modern transceivers can be connected by CAT to the ACOM 700S. This will allow the amplifier 

to track the transceiver frequency without any transmission and change the bands automatically when in 

OPERATE mode. 

 

The cable can be ordered separately from a third-party supplier or home-brewed according to Table 2-2 | 

Signals and pin out of the CAT/AUX connector and the transceiver's manual. 

 

 

NOTICE 

The CAT connection requires a cable made especially for the ACOM 700S and your 

transceiver. Using an inappropriate cable may cause a serious damage to the amplifier 

and your transceiver! 
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If you need cable wiring diagrams, please, see our document 

 • ACOM CAT cables Technical Information. 

The documentation is available for download at www.acom-bg.com. 

 

Note that some of the connections - to the transceiver's BCD band data outputs and 

Band Voltage outputs do not provide an exact frequency data, but only band data. Those 

connections cannot be used when ACOM 700S works together with ACOM 04AT or 06AT 

because the tuner needs to know the exact frequency, not only the band. 
 

 

Besides the RS-232 and TTL compatible serial interface, the CAT connector also carries 

the KEY IN and KEY OUT lines, which can be used instead of using separate cables for 

those functions from the transceiver to the sockets of the same names. 

 

Table 2-2 | Signals and pin out of the CAT/AUX connector 

CAT/AUX 

interface 
Pin Nr. Pin name Description Specification 

 
 

D-sub 

connector, 

15-pin, 

3-row, 

female 

(Rear panel 

view) 

1 RxD Receive Data TTL input 

2 RxD Receive Data RS-232 input 

3 TxD Transmit Data RS-232 output 

4 TxD Transmit Data TTL output 

5 GND Ground 0 Volt 

6 BAND voltage Analogue input 0 to +8 V 

7 Band data 0 Bit 0 TTL input 

8 Band data 1 Bit 1 TTL input 

9 Band data 2 Bit 2 TTL input 

10 Band data 3 Bit 3 TTL input 

11 ON RMT Remote Pwr On +4.5 to +15 V / 3 mA max 

12 Debug mode CPU only Pwr input +8 to +15 V / 0.4 A 

13 KEY IN  Tx request Less than +12 V / 6 mA 

14 KEY OUT Tx Ready O.C. output, up to +50 V / 20 mA 

15 GND Ground 0 Volt 

 

Table 2-2 | Signals and pin out of the CAT/AUX connector 
 

 

http://www.acom-bg.com/
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b) RS-232 interface connector 

Please, see Figure 2-4 | Rear panel - Connections, Pos. (4). 

RS-232 interface is used for Firmware Updates (see Section 7.5 Firmware) and for remote control (see 

Section 6 REMOTE CONTROL). 

 

Table 2-3 | Signals and pin out of the RS-232 connector 

RS-232 

interface 
Pin Nr. Pin name Description Specification 

 

D-sub 

connector, 

9-pin, 

female 

(Rear panel 

view) 

1 - Not connected - 

2 TxD Transmit Data RS-232 level output 

3 RxD Receive Data RS-232 level input 

4 - Not connected - 

5 GND Ground 0 Volt 

6 DSR Remote Power On RS-232 level input 

7 - Not connected - 

8 CTS Remote Power On RS-232 level input 

9 - Not connected -  

 

Table 2-3 | Signals and pin out of the RS-232 connector 
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3. FIRST POWER-ON, CONTROL SYSTEM, AND INITIAL CHECK 
 

 

NOTICE 

Do not turn the amplifier on for at least 2 hours after unpacking it in the room where it 

will be used. Pay particular attention when you move it from a very cold into a warm 

place - condensation is likely and this could result in damage to the high voltage circuits. 

In such a case, wait at least 4 hours. A similar effect can occur after a rapid warming of 

the operating room (for instance after switching on a powerful heater in a cold shack). 

 

 

NOTICE 

To avoid any damage (not covered by the warranty), never connect, or disconnect cables 

while power is applied at either end of the cable. 

Hot-plugging is technically incorrect and is a bad practice to connect or disconnect any 

piece of equipment while it is powered on. Make sure the device is switched off before 

connecting or disconnecting any cable. 

 

 

After following all instructions in Section 2 INSTALLATION, check whether the rear panel mains rocker switch 

(marked ON/OFF) is turned OFF (see Figure 2-4 | Rear panel - Connections, Pos. (1)). Then insert amplifier's 

mains plug into the wall outlet prepared for it. The amplifier remains switched off. 

 

Figure 3-1 | Front panel - Controls and Readouts 

 
Figure 3-1 | Front panel - Controls and Readouts 

 

 

c) 

a) 

b) d) 
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3.1. Low Energy STANDBY Mode of the Power Supply 

 

Now you can turn on the mains rocker switch marked ON/OFF (see Figure 2-4 | Rear panel - Connections, Pos. 

(1)). This will activate only the low-energy STANDBY mode of the amplifier power supply and the red LED 

above POWER button will light up (see Figure 3-1 | Front panel - Controls and Readouts, Pos. (b)), while the 

main power supply is still off and the display is dark. 

 

 

3.2. Front Panel  

 

a) POWER button 

Please, see Figure 3-1 | Front panel - Controls and Readouts (Pos. (a). 

When the rear panel mains rocker switch is turned on, push, and hold the POWER button for 1-2 seconds 

to start the amplifier up. When the amplifier is turned on, push the POWER button to turn off the amplifier 

(back to low energy STANDBY mode). 

 

b) LED indicator above the POWER button 

Please, see Figure 3-1 | Front panel - Controls and Readouts (Pos. (b). 

When lit red and the screen is dark, the amplifier is in low energy STANDBY mode and may be turned on by 

pushing the POWER button. 

When you want to fully disconnect the mains power, switch off also the rear panel rocker switch (see Figure 

2-4 | Rear panel - Connections, Pos. (1)). The front-panel red LED should go off and the POWER button will 

become inoperative. 

 

c) Functional buttons 

Please, see Figure 3-1 | Front panel - Controls and Readouts (Pos. (c). 

Six functional buttons keypad for manual (local) control of the amplifier. The function of each button is 

indicated on the display above it. Depending on the displayed menu, the buttons may have different 

functions (soft key). 

 

d) A high resolution, 24-bit color display showing the operating information. 

Please, see Figure 3-1 | Front panel - Controls and Readouts (Pos. (d). 

 

 

3.3. Initial Turning On 

 

In order to start up the amplifier, push and hold the front panel POWER button for one or two seconds. 

About ten seconds later (boot sequence) the display will flash and show the basic screen with the amplifier 

information (see Figure 3-2 | Basic screen). 

 

The amplifier may start in either STANDBY or OPERATE mode depending on AUTO OPERATE user setting 

(see Section 4.1.c) AUTO OPERATE user setting).  
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3.4. Basic Screen 

 

The following information areas are to be distinguished on the basic screen: 

 

a) Information area for the frequency band  

Please, see Figure 3-2 | Basic screen, Pos. (a). 

The edges of the currently selected BAND are displayed. If the amplifier does not receive any operating 

frequency data from CAT or via RS-232, it will switch to the last used band. 

 

Figure 3-2 | Basic screen 

 
 

Figure 3-2 | Basic screen 

 

 

b) Operating values and alarm messages area  

Please, see Figure 3-2 | Basic screen, Pos. (b). 

Any two operating values selected in the AMP MEASURE menu will be shown here (see Section 5.1 Menu 

AMP MEASURE (Amplifier Measurements)). 

 

The alarm messages (either WARNING or SOFT FAULT) appear on yellow background on the same area and 

are flashing frequently in order to attract the operator's attention (see Figure 4-4 | Appearance of an alarm 

message). 

 

The WARNING messages appear only temporarily (for about three seconds), afterwards the indication of 

the operating values is restored automatically (see Section 4.4.a) First protection level - WARNING). 

 

The SOFT FAULT messages appear in the same field but they remain on the screen until the AUTO OPERATE 

time is elapsed (see Section 4.1.c) AUTO OPERATE user setting) or until the operator pushes any button, then 

the operating values (regime measurands) indication is restored too. 

d) 

c) 

b) 

g) 

e) 

a) 

f) 

i) 

h) 

1 2) 
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c) Working mode indicator - OPR, STB or AUTO OPER 

Please, see Figure 3-2 | Basic screen, Pos. (c). 

For detailed information, please, see Section 4.1 Change of Modes RX/TX and OPERATE/STANDBY; AUTO 

OPERATE User Setting. 

 

d) RX/TX indicator  

Please, see Figure 3-2 | Basic screen, Pos. (d). 

RX/TX indicator reads the request for transmit (KEY IN input). The RX indication is green and the TX is red. 

The indicator will flash frequently if switch over is impossible. 

 

e) Forward power bar graph and digital readout 

Please, see Figure 3-2 | Basic screen, Pos. (e). 

Displays the forward power fed into the antenna. 

 

f) Reflected power bar graph and digital readout 

Please, see Figure 3-2 | Basic screen, Pos. (f). 

Displays the power reflected from the antenna. Entering the red zone is not allowed. 

 

g) PA transistor temperature bar graph and digital readout 

Please, see Figure 3-2 | Basic screen, Pos. (g). 

Entering the red zone is not allowed. 

 

h) CAT interface information 

Please, see Figure 3-2 | Basic screen, Pos. (h). 

When CAT is deactivated, this field is shaded. 

 

i) REMOTE CONTROL information field 

Please, see Figure 3-2 | Basic screen, Pos. (i). 

Flashing the REMOTE CONTROL represents RS-232 port dataflow. 

 

 

3.5. Control System - Buttons and Menus 
 

1) The OPR/STB and the BAND buttons 

 

The OPR/STB and the BAND buttons are used for manual (local) control. 

Please, see Figure 3-2 | Basic screen, Pos. (1): 

• The left-most button OPR/STB switches over the amplifier between OPERATE and 

STANDBY modes; 

• The next two buttons - BAND up  and down  arrows change the frequency bands in 

ascending or descending order. 
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When ACOM 04AT or 06AT tuner is assigned, BAND buttons are called SEGMENT and change 

the tuner frequency segments (see Section 4.3 Operation with an External Antenna Tuner). 

 

 

2) MENU button 

 

The right-most button MENU provides access to the amplifier's settings and service functions. 

Please, see Figure 3-2 | Basic screen), Pos. (2). 

• In each menu the left-most button is always HELP and the right-most - always EXIT; 

• The HELP button provides information about the active screen. 

For more details of the control system and use of the menus see Section 5 MENUS - SETTINGS AND OPTIONS. 

 

 

3.6. Test Transmission 

 

To make sure that you have installed the amplifier correctly, make a test transmission as described below. 

Repeat these tests for each new band and antenna, as well as after installing a new or modified antenna, 

antenna switch, tuner, and/or connecting cables. 

 

a) Check of RF bypass path of a non-driven amplifier 

 

 

When the ACOM 700S is powered off, there is a bypass from RF INPUT to RF OUTPUT. 

 

 

 

For this check the amplifier must be completely installed and connected according to Section 

2 INSTALLATION, but not powered by the mains, i.e., the mains rocker switch on the rear panel must be 

turned off. In any case the LED above the POWER button on the front panel must be dark for this test. 

 

First, check if the transceiver's reception is normal in some band that should be "open" at the time of test.  

Be sure to connect to the amplifier output an antenna having good SWR in the band being tested. If you 

observe a significant worsening of reception, first check for a problem in the coaxial connections to the 

amplifier (see Sections 2.4.d) RF INPUT connector and 2.4.e) RF OUTPUT connector). 

 

Provided the reception is normal, prepare the transceiver as follows: 

• Select a continuous carrier mode (CW, RTTY, FM); 

• Switch the microphone off (decrease the mic gain), disable FSK; 

• Reduce the output power control to a minimum; 

• Select a suitable indication so that you can watch the RF power and SWR at the transceiver output; 

• If the transceiver has a built-in antenna tuner - switch it off. 
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Now in RECEIVE mode select a frequency which is not occupied at the moment and press shortly the PTT or 

TX key while watching the output power and the SWR readings. If the power or SWR at the transceiver 

output are too high (over 5 W or SWR over 2:1) release the key and check for the reason as follows: 

• Check again whether the power control is set at minimum; 

• Check whether the frequency is within the operating range of the selected antenna; 

• Check the good working order of the coaxial cables, connectors, and feed lines from the 

transceiver antenna connector through the amplifier, the antenna switch or external tuner (if 

there is one) to the BALUN transformer, and the antenna itself (see Section 2.4.e) RF OUTPUT 

connector). 

 

If the power and SWR are as expected, transmit again and while watching the power and the SWR readings, 

increase transceiver power gradually from minimum to maximum (but not more than 200 W in order to not 

overload the RF by-pass circuit in the amplifier). 

 

If SWR remains below 2:1 (preferably below 1.5:1) at the last test, decrease the power from the transceiver 

to minimum again and continue with the next check-up. 

 

b) Check-up in STANDBY mode 

 

Turn the amplifier on, as described in Sections 3.1 Low Energy STANDBY Mode of the Power Supply, 3.2 Front 

Panel, 3.3 Initial Turning On and 3.4 Basic Screen (see Figure 3-2 | Basic screen). 

 

Make sure that the amplifier is in STANDBY mode. Push the OPR/STB button if needed to change to STB. 

 

Repeat receive and transmit tests the same way you just did with the amplifier turned off. During these 

tests note also whether the forward and reflected power bar graph and digital readout (see Sections 3.4.e) 

Forward power bar graph and digital readout and 3.4.f) Reflected power bar graph and digital readout) show 

respective RF power presence. If the reflected power exceeds the forward power, verify that the input and 

output coaxial cables to the amplifier are not interchanged (see Section 2.4.d) RF INPUT connector and 2.4.e) 

RF OUTPUT connector). 

 

 

The power indication accuracy is optimized around the 700 W level and usually it is 

unreliable below 40 W. 
 

 

c) Entering OPERATE mode 

 

At OPERATE mode the transceiver receiving should not suffer. If it worsens and together with this the 

indicator RX changes into TX although the transceiver is in receive mode, check the control cable connected 

to the KEY IN input (see Section 2.4.b) KEY IN connector) for a short circuit. A wrong connection to the 

transceiver could cause the same problem. 
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d) Test transmission with the amplifier 

 

If not readily set by CAT, switch the amplifier to the same band as the transceiver and antenna (see Section 

3.5.1) The OPR/STB and the BAND buttons). 

 

Set the transceiver to a continuous carrier mode and minimum power. In OPERATE mode choose a free 

frequency and push the PTT or CW key briefly, while watching the amplifier's behavior: 

• RX mode must change to TX; 

• The reflected power must read below 20 W; 

• The forward power must read between 20 and 150 W with minimum drive power from the 

transceiver (between 1 and 5 W). 

 

If the above test goes normally, push briefly the PTT once again, this time watching the transceiver's SWR 

reading (i.e., the input SWR of the amplifier) - this must be below 1.2. 

If the SWR to the transceiver is higher than 1.2, check the coaxial cable between transceiver's output and 

amplifier's input socket (see Section 2.4.d) RF INPUT connector). 

 

e) Setting of drive level and typical operation 

 

After successfully passing of the above tests push PTT or CW key for several seconds, watching the forward 

and reflected power. Increase the drive power until the forward power bar graph and digital readout reach 

700 W. 

 

Upon reaching 700 W forward power check the following parameters (continuous carrier operation): 

• The reflected power must not exceed ~78 W (for SWR 2:1) or better still to be below 28 W 

(for SWR 1.5:1); 

• PA DC CURRENT must be between 23 and 30 A; it is normal that the current varies within 

these limits when changing operating frequency and antenna impedance; 

• PA DC VOLTAGE must be within 42-44 V; 

• The transceiver's SWR reading must be below 1.2:1. 

 

Enter the MEASURE menu (see Figure 5-2 | Menu AMP MEASURE) and check: 

• Тhe drive power from the transceiver must be between 22 W and 29 W; 

• PA BIAS, which must be between 2.4 and 2.8 V; 

• PA TEMPERATURE, which must be between the ambient and 95 oC (203 oF), depending on the 

power level and the duration of transmission. 

 

f) Elimination of electromagnetic compatibility (EMC) problems 

 

If you use an amplifier for the first time in your shack, you may need to make some improvements in the 

setup. It is possible you might experience tingling from metallic objects due to the stronger radiated RF 

field. It could affect the operation of your station or systems outside, if they are too sensitive - typical 

examples are the microphone, CW keyer, computer keyboard or mouse, as well as TV receivers, Hi-Fi, 

intercom or telephone setups and others. 
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For instance, induction of RF currents into the microphone, CW keyer or computer keyboard, may lead to 

distortion in the peaks or relaxation oscillation in SSB mode, "sticking" or breaking off the dots or dashes 

from a Morse keyer, or garbling computer screen images. 

 

For the elimination of such problems, we recommend that you take the following general measures: 

• Minimize the radiation from the feed lines by reducing the common mode currents in them, 

improve the balance of antennas and feedlines; 

• In case you use asymmetric antennas (GP and similar) install as many radials as practical (use 

a well-developed counterpoise system); 

• Add current chokes on the coaxial feeders; 

• Place as far away as possible (also by height) the radiating elements of antennas from the 

premises, where the affected devices are located; in this sense, asymmetrical antennas without 

a separate feeder (Long Wire, Windom, and similar) may cause more interference because 

their radiating element begins immediately from the shack (part of it is the feeder itself); 

• If the use of asymmetrical directly fed "wire" antennas is inevitable, use mainly half wave or 

half wave multiple - they have a high input impedance, operate respectively with a small 

current in the feed point, and in the grounding of the shack; thus you can reduce the strength 

of the disturbing RF fields more than 10 times (at the same radiated power) compared to the 

case with quarter-wave and multiple to quarter-wave antennas of this class - you should 

avoid them because they have a low input impedance and operate with a large RF current in 

the grounding system and in the power supply network respectively, i.e. they create stronger 

disturbances (RFI); 

• Improve the RF grounding system: use the shortest and widest possible metal strips for the 

connections to ground and between the different gear in the shack; connect one or more 

counterpoises (sized for the problematic band) to the feeder shield at the point, where it 

enters the building, and the same point - with the possibly shortest and widest connections - 

to the grounding system: this is a very efficient measure, in particular if the shack is located 

on a high floor above ground; 

• To reduce the RF impedance of the grounding connections sheet metal stripes instead of 

flexible braids are preferred; 

• Thread ferrite beads or snap-in ferrites with medium permeability (800-4000) over the power 

cord, the feeder and the signal cables leading to the affected devices (TV, etc.); besides the 

size, consider the frequency range in which the offered ferrites are effective - normally they 

are optimized for suppression of interferences on HF (with larger permeability), with medium 

permeability for HF-VHF or with low permeability - only the VHF range. The latter are 

ineffective for HF; 

• Whenever possible use shielded cables and ground their shields at both ends; 

• The addition of even quite simple low pass L/C or R/C filters directly to the disturbed inputs 

or outputs of the devices is very effective, provided it is practically applicable. 

 

Last but not least, bear in mind that the benefit of the above measures is two-fold. 

Firstly - they reduce the interferences from your transmissions to the ambient environment and secondly - 

they reduce the background noise floor for your reception. 
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Practically, with no great efforts, implementing the above measures, you can reduce the receive 

background noise floor with one or more S-units across the different bands. This will allow you not to miss 

weaker stations, which will hear you because of your increased transmission power. 

And third, but very important: the EMI environment at your station will become safer for you and those 

close to you. 
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4. OPERATION 
 

4.1. Change of Modes RX/TX and OPERATE/STANDBY; AUTO OPERATE User Setting 

 

a) STANDBY mode 

 

In STANDBY mode, as well as, when the amplifier is powered off, receiving and 

transmitting (no more than 200 W) with the transceiver is done via RF bypass path 

through RF INPUT to RF OUTPUT of the amplifier. 

 

 

In STANDBY mode, as well as when the amplifier is powered off, the transceiver's RF power is not amplified, 

the control KEY IN input does not affect the operation, and the KEY OUT output (see Section 2.4.c) KEY OUT 

connector) follows the KEY IN input unconditionally. The bands cannot be changed neither manually nor by 

CAT or remotely. 

 

b) OPERATE mode 

In OPERATE mode the receive-transmit (RX/TX) direction is controlled by the KEY IN input: 

• At open KEY IN (OPERATE/RX mode), the transceiver receives the signals from the antenna 

through the same RF bypass path between RF INPUT and RF OUTPUT as with amplifier 

turned off or in STANDBY mode; 

• At grounded KEY IN (OPERATE/TX mode) the RF drive is amplified and fed to the antenna 

through the RF OUTPUT connector. 

 

 

The transceiver must send a "Ground on transmit" signal to the amplifier KEY IN input at 

least 10 ms before sending the RF drive signal to the amp's RF INPUT. This time (10 ms or 

more) is necessary for the amp's relays to switch safely from receive to transmit status.  

Read your transceiver's manual for instructions.   

Otherwise, the protection system will read "HOT SWITCHING ATTEMPT" and will trip off. 
 

 

In OPERATE mode the KEY OUT output (see Section 2.4.c) KEY OUT connector) follows the KEY IN input only 

after all conditions for safe transmission have been found good by the amplifier control unit. The KEY OUT 

output duly disables transmission while the amplifier is not ready. 

 

The two modes OPERATE and STANDBY may be changed in three ways: 

• Manually (locally) - by pressing the OPR/STB button alternatively (see Figure 3-2 | Basic screen); 

• Automatically at a SOFT FAULT protection trip - when the AUTO OPERATE user setting is 

activated (see Section 5.4.c) AUTO OPERATE); 

• By a remote-control command. 
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Access to the OPERATE mode can be locked in the AMP SERVICE menu, the OPERATE 

ACCESS user setting (see Section 5.2 Menu AMP SERVICE (Amplifier Service Functions) and 

Figure 5-3 | Menu AMP SERVICE). 
 

 

c) AUTO OPERATE user setting  

AUTO OPERATE user setting can be turned on/off by the operator in the USER PREFERENCES menu (see 

Section 5.4 Menu USER PREFERENCES and Figure 5-5 | Menu USER PREFERENCES) or by a remote control 

command. 

 

When the AUTO OPERATE user setting is OFF, the two modes OPERATE and STANDBY can be changed 

alternatively by the OPR/STB button or by a remote-control command. At a SOFT FAULT protection trip, the 

amplifier will revert to STANDBY and wait for the operator to return it to OPERATE by pressing the OPR/STB 

button. 

 

When AUTO OPERATE is ON (see Section 5.4 Menu USER PREFERENCES), the amplifier will start up in 

OPERATE mode as soon as you turn it on. At a SOFT FAULT protection trip, the amplifier will also revert to 

STANDBY, but will return automatically to OPERATE mode in about 4 seconds. 

 

Even at AUTO OPERATE on, the operator can revert to and remain in a STANDBY mode manually by the 

OPR/STB button or by a remote command. The next OPR/STB button push or remote command will switch 

the amplifier to the OPERATE mode and restore the normal operation of the AUTO OPERATE user setting. 

 

 

4.2. Band Change, Standard and Expanded Frequency Coverage 

 

When connected to a transceiver with CAT, the amplifier will change frequency bands automatically, 

following the transceiver's operating frequency changes. 

 

Without CAT connection, the bands can be changed either manually or automatically (by the built-in 

frequency counter). 

 

The bands are changed manually by the up  and down  BAND buttons. 

 

For an automatic band change via the built-in frequency counter, make a quite short pre-transmission 

(100 ms is enough) - a CW dit, or a sound on SSB) and release the PTT for a moment before the main 

transmission. 

 

If the new frequency is out of the amplifier's frequency range (see Section 8.1.a) Standard Frequency Coverage), 

the transmission request will be denied and the following fault message will appear on the screen: 

 

"FREQUENCY OUT OF RANGE" 

 

 

The amplifier specifications are guaranteed within the bands listed in Section 

8.1.a) Standard Frequency Coverage. 
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4.3. Operation with an External Antenna Tuner 

 

NOTICE 

To avoid damage (not covered by the warranty) do not change antennas while 

transmitting. Do not transmit into an antenna output if it is not connected to an antenna 

or a dummy load via a suitable coaxial cable with a PL-259 plug (see Section 2.4.e) RF 

OUTPUT connector). 

  

 

At antenna SWR over 1.5:1, it is advisable you use an external tuner. 

 

The ACOM 04AT Remote Automatic Antenna Tuner and Switch (see Figure 4-1 | ACOM 04AT tuner mounting 

possibilities) and ACOM 06AT Automatic Antenna Tuner and Switch (see Figure 4-2 | ACOM 06AT automatic 

antenna tuner and switch (shown near 700S amplifier)) are designed to work with our transistor (solid-state) 

amplifier series, including the ACOM 700S. 

 

ACOM 04AT and 06AT tune antennas having SWR up to 3:1 automatically, thus providing an optimum load for 

the amplifier within 5 seconds with improved harmonic suppression at that. The four-way antenna switch is 

controlled automatically or from the amplifier front panel. 

 

The ACOM 04AT can be installed both in the shack and in a remote location (even out in the open, close to 

the antennas). It can be distanced up to 100 m (330 ft) from the amplifier, using a single coaxial cable. 

 

Figure 4-1 | ACOM 04AT tuner mounting possibilities 

   
 

 

Wall mounted tuner Mast mounted tuner Desk mounted tuner 

 

Figure 4-1 | ACOM 04AT tuner mounting possibilities 

 

 

ACOM 06AT tuner is designed for indoor use only! It can be located up to 100 m (330 ft) away from the shack, 

using a single coaxial cable. 

 

The connection of ACOM 04AT or 06AT tuner will make accessible specific features on the amplifier display 

that provide a transparent operation by following frequency and antenna selection changes in less than 

50 ms. 
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Figure 4-2 | ACOM 06AT automatic antenna tuner and switch (shown near 700S amplifier) 

 
Figure 4-2 | ACOM 06AT automatic antenna tuner and switch (shown near 700S amplifier)  

 

Figure 4-3 | Amplifier screen with ACOM 04AT or 06AT antenna tuner installed 

 
 

Figure 4-3 | Amplifier screen with ACOM 04AT or 06AT antenna tuner installed 

 

 

The operation of ACOM S-series amplifiers (solid-state devices) with ACOM 04AT and 

06AT are described in detail in the respective User's Manual: 

 • ACOM 04AT User's Manual; 

 • ACOM 06AT User's Manual. 

The documentation is available for download at www.acom-bg.com. 

 

 

Pay particular attention to Sections 3.2 Indications, controls and menus, and 4.2 Tuner 

Assignment and Unassignment in the downloaded manual for details on ACOM 04AT or 

06AT control from amplifier front panel. 

 

 

The use of non-ACOM antenna tuners is not recommended. 

ACOM, as an Original Equipment Manufacturer, keeps the right to refuse the guarantee 

claims if the non-ACOM tuner is used. 

http://www.acom-bg.com/
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4.4. Automatic Protection System 

 

The ACOM 700S control unit (see Section 7.4 Using the Fault Codes (signatures) for Diagnostics) keeps track of 

most amplifier analogue and logic signals in all modes. 

 

Those are the receive/transmit control signal, the output relay contact state and switching times, the RF 

drive frequency and drive power (the input power), the final transistors DC current and DC voltage on the 

drains as well as, the gates bias voltage and the heat sink temperature, the main power-supply components 

temperature, the RF output forward and reflected power, and others. Some derivative parameters, as the 

power gain, the antenna SWR, and others, are watched too. 

 

In the event a parameter limit is violated, the amplifier will assess the risk and will trigger one of the three 

levels of protection, as described in items (a) to (c) below. Every event is accompanied by a warning text on 

the screen (see Figure 4-4 | Appearance of an alarm message). A sound alarm will be also produced, if set on 

in the USER PREFERENCES (see Figure 5-5 | Menu USER PREFERENCES). 

 

Figure 4-4 | Appearance of an alarm message 

 
 

Figure 4-4 | Appearance of an alarm message 

 

 

a) First protection level - WARNING 

The first (most forgiving) protection level is WARNING. When a value watched by the control unit 

approaches the protection threshold, the transmission is not interrupted, but a message appears - for 

example: 

"DRIVE POWER TOO HIGH" 

"DRAIN CURRENT TOO HIGH" 

or another (see Figure 4-4 | Appearance of an alarm message). 
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You can continue to transmit in these conditions, but you have to take some measures, for example, to 

reduce a bit the drive power from the transceiver. The warnings remain on the screen for at least three 

seconds so that they can be read through and will disappear after the reason has dropped off. 

 

 

b) Second protection level - SOFT FAULT 

The second protection level is a SOFT FAULT - when a value exceeded the safe level, but does not put the 

amplifier in a danger of a failure. 

 

At the second level (SOFT FAULT) the amplifier reverts to STANDBY mode for four seconds or permanently 

if the AUTO OPERATE user setting had been activated (see Section 4.1.c) AUTO OPERATE user setting). A 

respective message is shown on the screen, for example: 

"EXCESSIVE REFLECTED POWER" 

"EXCESSIVE DRAIN CURRENT" 

and others, accompanied by a sound alarm (unless the sound had not been muted - see Section 5.4 Menu 

USER PREFERENCES). 

 

Unlike those for a WARNING, the SOFT FAULT messages remain on the screen and persist until the operator 

pushes any button - in order to confirm that the message is read - or until the OPERATE mode is resumed 

automatically if the AUTO OPERATE user setting is active (see Section 5.4 Menu USER PREFERENCES). 

 

A SOFT FAULT calls for fast and simple correcting actions by the operator, such as, for example, reducing 

the drive power, improving of load SWR through retuning the antenna tuner, antenna change, etc. 

 

 

c) Third protection level - HARD FAULT 

The third and most serious protection level is a HARD FAULT. The amplifier will be turned off automatically 

to avoid possible further damages. 

 

When the protection trips off, the data about the fault is stored in the memory and the front panel screen 

is blanked. There is also a sound alarm - a series of "F" sent in CW. 

 

If the reason for tripping the protection is not obvious, you can try to turn on the amplifier. If the amplifier 

allows this after the fault, a fault message will appear with information about the reason for the latest 

automatic shutdown (for example, overheating of the power supply unit or of the PA stage). 

 

After pushing any button, the fault message will disappear, and if there are no further problems (for 

example, the overheated unit has already cooled down), the amplifier operation will be restored. In the 

event a threshold is still violated, a new message will appear on the screen, or the protection will trip again 

immediately after the recovery attempt. 

 

 

If the problem persists, contact your dealer (see Section 1.9 Owner Assistance).  
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At each "HARD FAULT" shutdown the amplifier stores diagnostic data, concerning the controls and values, 

the trip time, and others. Your dealer or his service may ask you to copy or take a picture on the data from 

the amplifier screen or download it by RS-232 interface and store it in a computer file (see Section 5.5 Menu 

FAULTS LOG and 7.5 Firmware). 
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5. MENUS - SETTINGS AND OPTIONS 
 

By pushing the MENU button (the rightmost on Figure 3-2 | Basic screen) the user invokes the MENU 

SELECTION screen (see Figure 5-1 | MENU SELECTION). Each menu can be selected by the  ITEM or ITEM  

buttons and SELECT button. These are described below. 

 

The items in each menu are selected and controlled by the same six buttons as in the basic screen, but they 

have new functions now. 

 

Figure 5-1 | MENU SELECTION 

 
 

Figure 5-1 | MENU SELECTION 
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5.1. Menu AMP MEASURE (Amplifier Measurements) 

 

The menu AMP MEASURE (see Figure 5-2 | Menu AMP MEASURE) is accessible from the MENU SELECTION 

screen (see Figure 5-1 | MENU SELECTION) in all modes. Here you can constantly observe the values of eleven 

parameters. 

 

Two identical lists appear on the left and the right halves of the screen, each one containing the same 11 

values. 

 

Any value can be selected in each screen half. Using buttons  ITEM and ITEM  (up and down arrows) 

select the desired values. The two selected values will appear also on the basic screen continuously (see 

Figure 3-2 | Basic screen, Pos (b)) - after leaving this menu (EXIT button). 

 

Figure 5-2 | Menu AMP MEASURE 

 
 

Figure 5-2 | Menu AMP MEASURE 

 

 

The measured values of the quantities in the AMP SERVICE menu are indicative only. 

The ACOM amplifier is not a measuring instrument in the sense of a calibrated 

(laboratory) instrument, i.e. the measured values can not be used as a reference or 

compared with any other measured values from calibrated (laboratory) instruments. 
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5.2. Menu AMP SERVICE (Amplifier Service Functions) 

 

The amplifier service menu (see Figure 5-3 | Menu AMP SERVICE) is accessible from the MENU SELECTION 

screen (see Figure 5-1 | MENU SELECTION) at RX mode only. 

 

 

NOTICE 

The AMP SERVICE menu is used for checking and adjustment of the zero-signal (idle) 

drain current of the final transistors and for testing some functions and circuits of the 

amplifier when serviced. We recommend these procedures are carried out only by a 

trained service technician! 

 

 

The necessary service function is selected with the buttons  ITEM and ITEM  (up and down arrows). 

With the  SELECT and SELECT  buttons (left or right arrows) the selected function is turned ON or OFF. 

 

The inactive functions are greyed out and the active are red. When leaving a function submenu, it is turned 

off and deactivated automatically. At pressing the EXIT button all service functions are turned off, and the 

MENU SELECTION screen comes back (see Figure 5-1 | MENU SELECTION). At consecutive pushing of the EXIT 

button, the basic screen returns (see Figure 3-2 | Basic screen). 

 

Figure 5-3 | Menu AMP SERVICE 

 
 

Figure 5-3 | Menu AMP SERVICE 
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5.3. Menu CAT/AUX SETTINGS (Selection of CAT/AUX interface) 

 

After a CAT cable is connected to both the transceiver and amplifier, the correct settings for the transceiver 

have to be entered via this menu. If there is no CAT connection, OFF has to be selected as Interface type. 

 

Figure 5-4 | Menu CAT/AUX SETTINGS 

 
 

Figure 5-4 | Menu CAT/AUX SETTINGS 
 

 

The CAT settings are accessible only in RX mode (see Figure 5-1 | MENU SELECTION and Figure 5-4 | Menu 

CAT/AUX SETTINGS. An item is selected by the  ITEM and ITEM   buttons (up and down arrows). The value 

is set with the  SELECT and SELECT  buttons (left or right arrows). Your selection appears in square 

brackets [x] on the screen. 

 

If the amplifier CAT port is connected to the transceiver via either BCD Band Data or Band VOLTAGE output, 

select the respective interface type on top row and push EXIT button. The other items and values will be 

ignored with such a selection. 

 

If the CAT cable is plugged into the transceiver's serial port, select the interface and command set according 

to Table 5-1 | Transceiver interface. The baud rate has to be set to the same value as the transceiver's. The 

byte spacing and polling time may be left unchanged. 

Last select the interface type (RS-232 or TTL) according to the Table 5-1 | Transceiver interface and used 

connection, then push EXIT button to return to MENU SELECTION. 
 

 

NOTICE 

If there is no CAT connection, but CAT INTERFACE is selected (activated) an error 

message will be displayed when you change the band. 
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Table 5-1 | Transceiver interface 

Transceivers Interface Command set 

ELECRAFT RS-232 5 

ICOM (Connection to the REMOTE connector) TTL 1 

ICOM (Connection to the RS-232 port or CT17) RS-232 1 

KENWOOD TS-2000, 480, 590, 890, 990 and similar RS-232 5 

YAESU FT-101, 450, 950, 991, 1200, 2000, 3000, 5000, 9000 and similar RS-232 2 

YAESU FT-1000MP RS-232 4 

YAESU FT-817, 857, 897 TTL 3 

 

Table 5-1 | Transceiver interface 

 

 

Under CAT interface control, the amplifier follows the VFO "A" frequency changes only. 

The ACOM 04AT and 06AT automatic antenna tuners follow the frequency of the 

amplifier. 
 

 

If your transceiver has more than one VFO, as well as in SPLIT mode, use VFO "A" for 

transmission and for tuner control. If the amplifier frequency does not change over the 

CAT interface, make sure you are using VFO "A" on the transceiver, as the amplifier CAT 

interface only uses VFO "A" data. 
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5.4. Menu USER PREFERENCES 

 

Figure 5-5 | Menu USER PREFERENCES 

 

Figure 5-5 | Menu USER PREFERENCES 

 

 

a) ANTENNA TUNER/SWITCH INSTALLED 

If ACOM 04AT or 06AT antenna tuner is connected, select YES. See Section 4.3 Operation with an External 

Antenna Tuner and refer to ACOM 04AT or 06AT User's Manual (available for download at www.acom-bg.com). 

 

b) AUTOMATIC MENU EXIT 

When AUTOMATIC MENU EXIT is turned on, the amplifier exits the currently selected menu if no button 

has been pressed for more than 5 minutes. 

If AUTOMATIC MENU EXIT is turned off, the amplifier remains in the currently selected menu until the EXIT 

button is pushed. 

 

c) AUTO OPERATE 

The AUTO OPERATE user setting is described in Sections 3.3 Initial Turning On and 4.1.c) AUTO OPERATE user setting. 

 

d) CALL SIGN 

If entered here, a call sign (or another text) will be included in any Fault Log file generated by the amplifier 

(see Section 5.5 Menu FAULTS LOG). The call sign (or another text) will not replace ACOM 700S logo on the 

startup screen. 

Use the  SELECT and SELECT  buttons (left or right arrows) to select the character position. The  ITEM 

and ITEM  buttons (up and down arrows) change the characters. 

Finish by moving the pointer out of the editable fields by means of the  SELECT (left arrow) button. 

http://www.acom-bg.com/
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e) OPERATE ACCESS 

When locked, the amplifier remains in STANDBY and cannot be switched to OPERATE unless unlocked in 

the same menu. Passwords are not used - this is only a simple protection against possible child actions, or 

involuntary switching to OPERATE mode. While locked, an attempt for entering OPERATE mode will result 

in a message: 

"OPERATE MODE IS LOCKED" 

 

The other preference items do not need explanation. 

 

 

5.5. Menu FAULTS LOG 

 

This function reads on the screen the information stored in the memory about the last 28 HARD FAULT 

protection trips (see Figure 5-6 | Menu FAULTS LOG). By pushing the FILE button, the information may be also 

downloaded in a plain-text format file through the RS-232 port and a computer using a standard terminal 

emulating program (TTY). The RS-232 protocol settings are: 9600, 8 N 1. 

 

Please, see Section 7.4 Using the Fault Codes (signatures) for Diagnostics. 

 

Figure 5-6 | Menu FAULTS LOG 

 
 

Figure 5-6 | Menu FAULTS LOG 
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5.6. Menu RESTORE DEFAULT SETTINGS 

 

Four different factory-reset levels are available (see Figure 5-7 | Menu RESTORE DEFAULT SETTINGS). 

In order to confirm the selected action, the operator must push the  ACTION (down arrow) button once 

more (as YES confirmation). After restoring the default settings, the control will return to the MENU 

SELECTION screen (see Figure 5-1 | MENU SELECTION). 

If the ACTION  (up arrow) button is pressed, the NO is selected again, and the control will not leave the 

current position. 

At pressing the EXIT button in this position, the control leaves this menu without changing anything and 

returns in the previous window (the MENU SELECTION screen). 

 

Figure 5-7 | Menu RESTORE DEFAULT SETTINGS 

 
 

Figure 5-7 | Menu RESTORE DEFAULT SETTINGS 
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6. REMOTE CONTROL 
 

Remote control of ACOM 700S is provided by either ACOM eBox Ethernet Remote Control device or RS-232 

port. 

 

6.1. Remote Control via ACOM eBox 

 

Remote control of ACOM 700S via Internet is provided by the ACOM eBox Ethernet Remote Control device.  

 

Figure 6-1 | ACOM eBox Ethernet Remote Control device 

 
Figure 6-1 | ACOM eBox Ethernet Remote Control device 

 

 

The operation of ACOM 700S with ACOM eBox is described in ACOM eBox User's Manual. 

 

 

For further information, please, see our document 

 • ACOM eBox User's Manual. 

The documentation is available for download at www.acom-bg.com. 

 

 

If you need cable wiring diagrams, please, see our document 

 • ACOM CAT cables Technical Information. 

The documentation is available for download at www.acom-bg.com. 

 

 

Use of other remote-control devices is not recommended. 

 
 

 

6.2. Remote Control via RS-232 interface 

 

The ACOM 700S may be controlled remotely by the RS-232 port. 

For cable connection, please see Section 2.5.b) RS-232 interface connector and Table 2-3 | Signals and pin out of 

the RS-232 connector. 

 

 

For ACOM 700S RS-232 interface protocol, please, contact your dealer (see Section 

1.9 Owner Assistance). 

http://www.acom-bg.com/
http://www.acom-bg.com/
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7. MAINTENANCE 
 

 

 DANGER 

Both the mains voltage and the high DC voltage up to 500 V inside the ACOM 700S 

amplifier are LETHAL! 

For your safety, pull the amplifier power plug out of the mains wall outlet and WAIT AT 

LEAST 3 minutes EACH TIME BEFORE you remove the cover of the amplifier. 

 

 

If no indicator glows upon switching the amplifier ON, the main fuse(s) may have blown 

(see Section 7.3 Fuse Replacement).  
 

 

7.1. Periodic Maintenance 

 

a) Periodic checks 

Periodically (but at least once per year) check all connections, contact cleanliness and the tightening of all 

connectors, in particular the coaxial ones. 

 

Check the integrity of the cables, in particular when they are laid on the floor. Check also if the cables are 

secured well in the area where they come out of the connector body. 

 

Pay particular attention to the mains plug and the wall outlet (see Sections 2.4.g) Power cord and 2.4.h) 

Preparation of wall outlet. If you have any doubts consult with a qualified electrician. 

 

Periodically check the SWR of the antennas and if this changes over time. Problems could occur more often 

in poor weather conditions - rain, snow, strong wind etc. 

 

b) Air filter 

ACOM 700S has one air filter that is accessible from the rear (see Figure 2-4 | Rear panel - Connections, Pos. (2)). 

Periodically (more often in a dusty environment, but at least once per year) clean the air filter without 

opening the amplifier. 

 

 

 CAUTION 

The air filter may be too dusty - be careful how you clean it so that you DO NOT INHALE 

(BREATHE IN) neither spill the dust over! Wrap it, for instance, in a wet cloth before 

cleaning! 

 

 

The filter is contained in an externally mounted plastic enclosure. The cover of the enclosure, together with 

the filter itself, is removed by gently pulling it away from the amplifier. Carefully clean the filter and cover 

from dust, wash it with tap water and leave it to dry up before you mount it back. 

Finally put the filter back in the filter enclosure cover and click the cover back in place. 
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7.2. Cleaning 
 

 

 CAUTION 

Do not use any solvents for cleaning. They may be dangerous to you and damage 

amplifier surfaces, paint, and plastic components. 

 

 

Do not open the amplifier. Cleaning of the amplifier outer surfaces can be done with a piece of soft cotton 

cloth lightly moistened with clean water. 

 

Also, clean (as much as possible from the outside, without opening the amplifier) all ventilation apertures 

on the cover and the chassis, including the ones on the bottom.  

 

 

 DANGER 

Never push or put anything into holes in the case - this will cause electric shock. 

 

 

7.3. Fuse Replacement 
 

 DANGER 

If replacement of fuses is necessary, first pull out the amplifier mains plug from the 

mains outlet and wait for at least 3 minutes! 

 

 

NOTICE 

For replacement, only use standard fuses from the types recommended below. 

 

 

The two Primary Mains Fuses of the amplifier are located on the rear panel (see Figure 2-4 | Rear panel - 

Connections, Pos. (f)). They are fuses of the "F" type (fast-acting / quick-acting / quick blow), European size 

5x20 mm, ceramic (or glass) body cartridge. 

 

The fuses must be rated for a current corresponding to your mains nominal voltage: 

• 10 A / 250 V for operation from 200-240 VAC; 

• 16 А / 250 V for operation from 100-120 VAC. 

 

Suitable 10 A fuse is: 

• Littelfuse, PN: 0217010.H (glass body cartridge); 

This fuse can be ordered from: 

- DigiKey (www.digikey.com), PN: 0217010.MXBP-ND;  

- Farnell (www.farnell.com), PN: 1191761; 

- Mouser (www.mouser.com), PN: 576-0217010. 
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Suitable 16 A fuses are: 

• Littelfuse, PN: 0216016.MXP (ceramic body cartridge); 

This fuse can be ordered from: 

- Farnell (www.farnell.com), PN: 1354551; 

- Mouser (www.mouser.com), PN: 576-0216016. 

• ESKA, PN: 520.030 (glass body cartridge); 

This fuse can be ordered from: 

- TME (www.tme.eu), PN: ZKS-16A/250V. 

 

 

If, after Primary Mains Fuses replacement, the device does not operate normally, we 

recommend repair, performed only by a trained service technician. 

Contact your ACOM dealer for assistance (see Section 1.9 Owner Assistance). 

 

 

Besides the primary fuses, there are internal fuses inside the amplifier. 

 
 WARNING 

Do not replace internal fuses located inside the amplifier. 

Blown internal fuses can be a symptom of a more serious problem, which should be 

resolved beforehand. A fault of this type will not occur under normal operating 

circumstances. 

Replacing internal fuses is a complex and potentially dangerous operation. 

For this reason, we recommend this work be carried out only by a trained service 

technician. 

Contact your ACOM dealer for assistance (see Section 1.9 Owner Assistance). 

 

 

Unauthorized replacement of inside fuses infringes the warranty conditions! 

 

  

 

Besides several specific national standards, the principal fuses standard applied 

worldwide is IEC 60127. 
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7.4. Using the Fault Codes (signatures) for Diagnostics 

 

The data of the last 28 HARD FAULT protection trips is stored in the amplifier memory (see Section 5.5 Menu 

FAULTS LOG). 

 

The data can be downloaded from the memory through the RS-232 port and stored in a computer file even 

if the amplifier cannot be turned on after a serious fault - only external power has to be fed to the Control 

unit in either of the following ways: 

 

• External 8 to 15 VDC voltage applied to the "DEBUG mode" input (see Table 2-2 | Signals and 

pin out of the CAT/AUX connector) of the CAT/AUX port. The power supply has to be capable to 

provide 0.4 A of current; 

 

• If the Control board has already been removed from the amplifier, it can be powered directly 

with +5 V (0.4 A) and the fault log downloaded via the RS-232 port. 

 

In the FAULT LOG reading mode (see Figure 5-6 | Menu FAULTS LOG), the Control board automatically 

transmits the data from the memory trough the RS-232 interface (see Section 2.5.b) RS-232 interface 

connector). The RS-232 protocol settings are: 9600, 8 N 1. Depending on the number of fault events stored 

in the memory, the transmission may take between 0.5 and 12 seconds. A pause of 6 seconds follows, then 

transmission starts again. The data can be read in a plain-text format with a computer, using a standard 

terminal emulating program (TTY). 

 

You can send the recorded file to your dealer or to ACOM accordingly. 

 

To decode the downloaded hexadecimal data, you have to use the ACOM Hard Faults Signatures Converter 

(Excel file), distributed by ACOM free of charge. You can download it from www.acom-bg.com. 

http://www.acom-bg.com/
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7.5. Firmware 

 

7.5.1. Firmware Versions 

 

The history of available ACOM 700S CPU Module firmware versions is shown in Table 7-1 | ACOM 700S 

firmware versions history. 

 

Table 7-1 | ACOM 700S firmware versions history 

Version Release Date Notes / Summary of changes 

1.0 2018 Base firmware version; 

1.6 19.05.2022 Small firmware improvements based on minor hardware changes; 

1.8 19.02.2024 - NEW function: "Active automatic protection" 

- CAT interface: properly set power before tune 

- Increase threshold for 5V max 

- YAESU CAT interface: restore MIC gain after tune 

- Improve code readability and add HW division (These changes are purely internal 

and have no effect on end user experience) 

- Disable Auto-Operate after Hard Fault Error 

- Fix: selection of polling time and byte spacing 

   

 

Table 7-1 | ACOM 700S firmware versions history 

 

 

The new firmware is issued as a file, for example ACOM_700S_FW V1.8 - 19.02.2024.DAT. 

 

 

The latest firmware versions for our products are available at www.acom-bg.com free of 

charge. 

 

 

7.5.2. Prequistments 

 

 

Before you change the firmware version, check the new version compatibility with the 

revisions of the hardware and of the boot loader in your amplifier (see Figure 5-6 | Menu 

FAULTS LOG). If you have any doubts about the versions, please, consult your dealer 

before you undertake any action. 
 

 

When ACOM issues a new firmware version, the user can upload it in the amplifier after he checks the 

compatibility. When compatibility is confirmed a return to an earlier version is also possible. 

 

 

http://www.acombg.com/
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We highly recommend updating your ACOM 700S amplifier with firmware version 1.8 or 

newer. 

The ACOM 700S firmware version 1.8 is compatible with all ACOM 700S amplifiers 

produced (see Section 1.4 Product History and Documentation Validity). 

 

 

For uploading (or backup) a firmware to ACOM 700S you have to use the ACOM Terminal S software, 

distributed by ACOM free of charge. You can download it from www.acom-bg.com. 

 

 

The ACOM Terminal S is available for MS Windows operation systems only. 

ACOM Technical Support Team can advise you om Terminal S use in the Windows 

environment. 

 

 

The ACOM Terminal S communicates with the amplifier via the RS-232 interface.  

 

To use the ACOM Terminal S, you have to install the software on PC equipped with: 

• RS-232 port (real port / build-in) as marked on the picture below: 

Figure 7-1 | Example of PC with RS-232 port (interface) 

 
 

Figure 7-1 | Example of PC with RS-232 port (interface) 

 

 

For the necessary RS-232 connecting cable see Table 7-2 | RS-232 connection cable wiring. 

 

http://www.acom-bg.com/
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Table 7-2 | RS-232 connection cable wiring 

ACOM 700S Rear panel 
Connecting cable 

Personal Computer 

RS-232 connector RS-232 connector 

 

 

D-sub 

connector, 

9-pin, 

female 

(Front 

view)  

1 | Not connected  

 

D-sub 

connector, 

9-pin, male 

(Solder view) 

 

1 Not connected -  

 

D-sub 

connector, 

9-pin, female 

(Solder view) 

1 | DCD  

 

D-sub 

connector, 

9-pin, 

male 

(Front 

view)   

2 | TxD 2 –––––––– 2 2 | RxD 

3 | RxD 3 –––––––– 3 3 | TxD 

4 | Not connected 4 Not connected - 4 | DTR 

5 | GND 5 –––––––– 5 5 | GND 

6 | DSR 6 Not connected - 6 | DSR 

7 | Not connected 7 Not connected - 7 | RTS 

8 | CTS 8 Not connected - 8 | CTS 

9 | Not connected 9 Not connected - 9 | RI 

Housing Housing Ext. shield Housing Housing 

 

 

 

 

Table 7-2 | RS-232 connection cable wiring 

 

 

OR 

 

• "USB to RS-232" converter. 

Nowadays, most computers do not have a built-in RS-232 interface (port). But all computers 

have a couple of USB ports. So, if this is your case you have to use a "USB to RS-232" 

interface converter. 

 

 

The ACOM recommends using "USB to RS-232" converters produced by FTDI 

(www.ftdichip.com) or based on an FTDI chip. 

 

Figure 7-2 | Examples of "USB to RS-232" converters 

 
USB (connector type C) to RS-232 converter USB (connector type A) to RS-232 converter 

 

Figure 7-2 | Examples of "USB to RS-232" converters 

Cable shield
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Suitable "USB to RS-232" converters are: 

 

• FTDI, PN: UT232R-200 (USB (connector type A) to RS-232 (connector D-sub, 9-pin, male), 2 m 

cable length) 

This converter can be ordered from: 

- DigiKey (www.digikey.com), PN: 768-1084-ND;  

- Mouser (www.mouser.com), PN: 895-UT232R-200; 

- Farnell (www.farnell.com), PN: 2352013. 

 

• FTDI, PN: UT232R-500 (USB (connector type A) to RS-232 (connector D-sub, 9-pin, male), 5 m 

cable length) 

This converter can be ordered from: 

- DigiKey (www.digikey.com), PN: 768-1085-ND;  

- TME (www.tme.eu), PN: UT232R-500; 

- Mouser (www.mouser.com), PN: 895-UT232R-500; 

- Farnell (www.farnell.com), PN: 2352014. 

 

• Digitus, PN: DA-70166 (USB (connector type C) to RS-232 (connector D-sub, 9-pin, male), 1 m 

cable length) 

This converter can be ordered from: 

 - TME (www.tme.eu), PN: DA-70166. 

 

 

7.5.3. Firmware Update Procedure 

 

 

The firmware update procedure below is based on a PC with Windows 11 operating 

system and the use of a "USB to RS-232" converter. The used PC has both RS-232 

interfaces: 

- "USB to RS-232" interface converter 

- RS-232 serial port/interface (in-build). 

 

 

The sample images below are based on used Terminal S software with a connected 

ACOM 500S amplifier. The firmware update procedure is the same for ACOM 700S and 

1200S amplifiers. 
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STEP 1 – RS-232 Interface Settings on your PC  

 

• Switch On your PC. Connect the "USB to RS-232" converter to any USB port on your 

computer, and do not connect the converter to the amplifier. 

 

• Go to Device Manager on your PC (right mouse click over Windows Start button -> Device 

Manager). The converter's driver should be installed automatically, and you can see a 

situation similar to Figure 7-3 | PC Device manager (if driver installation is OK).   

Make sure that the correct (newest) driver for your hardware is installed. 

 

Figure 7-3 | PC Device manager 

  
 

Figure 7-3 | PC Device manager 

 

 

Remember the serial (RS-232) port number. 

 

 

 

Port 

number 
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• Go to Serial port Properties (right mouse click over Device Manager -> Ports -> USB Serial 

Port -> Properties). You can see a situation similar to this: 

 

Figure 7-4 | PC Device manager -> Port properties 

 
 

Figure 7-4 | PC Device manager -> Port properties 
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• Go to Port Settings tab -> Advanced tab and change Latency Timer parameter to 1 msec. 

 

Figure 7-5 | PC Device manager -> USB Serial Port properties 

 

 

Figure 7-5 | PC Device manager -> USB Serial Port properties 

 

 

• Restart your PC 

 

Figure 7-6 | Restart Windows PC 

 

 

Figure 7-6 | Restart Windows PC 
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If you are using a PC with a built-in RS-232 port the above STEP 1 is similar and you have to go to Port 

Settings tab -> Advanced tab and change Receive/Transit buffer parameters to 1. 

 

Please note that these parameters depend on the hardware type/model of your built-in RS-232 port and 

may look different than the example below.  

 

Figure 7-7 | Examples PC Device manager -> Built-in RS-232 Port properties 

 
 

Figure 7-7 | Examples PC Device manager -> Built-in RS-232 Port properties 
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STEP 2 – Amplifier Settings 

 

• When the amplifier is turned on, push the POWER button to turn off the amplifier (back to 

Low Energy standby mode); 

• Switch off the amplifier via Main Power Rocker Switch (see Figure 2-4 | Rear panel - 

Connections, Pos. 1); Make sure the Main Power Rocker Switch is in OFF position; 

• Pull the amplifier's line (mains) plug out of the outlet; 

• Do not disconnect GND connection; 

• Disconnect all cables (except GND connection) from the rear panel of the amplifier – 

transceiver, antennas, etc. 

 

 

 DANGER 

Remove the GND connection last (see Figure 2-4 | Rear panel - Connections, Pos. (a)) and 

wait 30 minutes for safety.  

 

Figure 7-8 | Rear panel – RS-232 port 

 
Figure 7-8 | Rear panel – RS-232 port  

 

 

• Connect the amplifier to the PC via RS-232 interface on the rear panel of the amplifier (see 

Figure 7-8 | Rear panel – RS-232 port). 

- If your PC has a built-in RS-232 port, you have to use an RS-232 cable (see Table 7-2 | 

RS-232 connection cable wiring) to connect an amplifier to the PC. 

- If your computer does not have a built-in serial RS-232 interface use an "USB to RS-

232" converter (see Figure 7-2 | Examples of "USB to RS-232" converters). 

• Check whether the rear panel mains rocker switch (marked ON/OFF) is turned off (must be). 

Insert amplifier's mains plug into the wall outlet; 
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• Switch on the amplifier via Main Power Rocker Switch 

(see Figure 2-4 | Rear panel - Connections, Pos. 1); 

• Push and hold for 1-2 seconds the POWER button to start the amplifier and enter STANDBY 

mode. 

 

 

If the amplifier starts normally there will be a couple of beeps from the amplifier. 

 

 

 

STEP 3 – Using Terminal S software for Firmware Update 

 

• Exit all programs running on your computer and DISABLE/DEACTIVATE any antivirus software; 

• Start ACOM Terminal S software (We assume that you downloaded Terminal S software 

from www.acom-bg.com and installed it on your PC); 

 

Figure 7-9 | ACOM Terminal S screenshot 

 
 

Figure 7-9 | ACOM Terminal S screenshot 

 

 

• Open the Settings window by clicking on the Settings icon (two gears) or use Tools -> 

Settings from the menu bar. In the Settings window -> tab General, configure the settings as 

shown in Figure 7-10 | Terminal S - Tools -> Setting -> General menu: 

- Command timeout (ms)  10000; 

• In the Settings window -> tab Serial port, configure the settings as shown in Figure 7-11 | 

Terminal S - Tools -> Setting -> Serial port menu. For actual serial port number see STEP 1 – RS-232 

Interface Settings on your PC: 

- Serial port settings  9600, 8, None, 1; 
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Figure 7-10 | Terminal S - Tools -> Setting -> General menu 

 
 

Figure 7-10 | Terminal S - Tools -> Setting -> General menu 

 

Figure 7-11 | Terminal S - Tools -> Setting -> Serial port menu 

 
 

Figure 7-11 | Terminal S - Tools -> Setting -> Serial port menu 

 

 



User's Manual | ACOM 700S | 1.8-54 MHz Linear Amplifier  

Page 70 of 92 | S e c t i o n  MAINTENANCE April 2024 

 

• Connect ACOM Terminal S to the amplifier by clicking on the Connect icon (two connected 

plugs) or use Device -> Connect from the menu bar; 

 

Figure 7-12 | Terminal S - Connect to amplifier 

 
 

Figure 7-12 | Terminal S - Connect to amplifier 

 

 

• When connected click on the Firmware Upload/Download icon (two arrows in opposite 

directions) or use Device -> Firmware upload/download from the menu bar to activate the 

Bootloader; 

 

Figure 7-13 | Terminal S - Firmware Upload/Download 

 
 

Figure 7-13 | Terminal S - Firmware Upload/Download 

 

 

When the bootloader has been activated there will be beeps from the amplifier and the 

front display will go black. 
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• Click on the Disconnect icon (two separated plugs) or use Device -> Disconnect from the 

menu bar to disconnect from the amplifier. 

 

Figure 7-14 | Terminal S - Disconnect 

 
 

Figure 7-14 | Terminal S - Disconnect 

 

 

• Open the Settings window by clicking on the Settings icon (two gears) or use Tools -> 

Settings from the menu bar. In the Settings window -> tab Serial port, configure the settings 

as shown in Figure 7-15 | Terminal S - Change Bits per Second: 

- Serial port settings  34800, 8, None, 1 

(change "Bits per second" parameter only); 

 

Figure 7-15 | Terminal S - Change Bits per Second 

 
 

Figure 7-15 | Terminal S - Change Bits per Second 
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• Re-connect to the amplifier by clicking on the Connect icon (two connected plugs) or use 

Device -> Connect from the menu bar; 

 

Figure 7-16 | Terminal S - Reconnect 

 
 

Figure 7-16 | Terminal S - Reconnect 

 

 

• When connected click on the Firmware Upload/Download icon (two arrows in opposite 

directions) or use Device -> Firmware upload/download from the menu bar to activate the 

bootloader. A Bootloader menu will appear in the text box as shown below; 

 

Figure 7-17 | Terminal S - Bootloader menu 

 
 

Figure 7-17 | Terminal S - Bootloader menu 
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• Press the U letter from your keyboard to activate the Firmware Upload process. 

Press the Y letter from your keyboard to answer the question that appears: 

 

CURRENT FIRMWARE WILL BE ERASED! ARE YOU SURE (N/N)? 

 

A new dialog box will open asking for the new firmware file name and location. Open the 

folder that contains the new firmware file (*.dat), select the file, and press the Upload 

button (We assume that you downloaded the newest firmware from www.acom-bg.com and 

unzipped it on your PC); 

 

Figure 7-18 | Terminal S - Upload firmware process 

 
 

Figure 7-18 | Terminal S - Upload firmware process 

 

 

The Upload firmware process may take approx. 3-6 minutes.  

 

 

During the Firmware Update Process, the user's amplifier settings are kept and are 

available in the new firmware version. 
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• Press the B letter from your keyboard to activate the Firmware Backup process. 

A new dialog box will open prompting you to enter a name and location for the new backup 

file. Press the Download button to start the process; 

 

Figure 7-19 | Terminal S - Backup firmware process 

 
 

Figure 7-19 | Terminal S - Backup firmware process 

 

 

The Backup firmware process may take approx. 3-6 minutes.  

 

 

It is not obligatory to back up your current firmware because all firmware versions are 

available for download from www.acom-bg.com. 

 

 

http://www.acom-bg.com/
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• Press the E letter from your keyboard to exit from the process. Click on the Disconnect icon 

(two separated plugs) or use Device -> Disconnect from the menu bar to disconnect from the 

amplifier. Click on the File -> Quit from the menu bar to close Terminal S; 

 

Figure 7-20 | Terminal S - Exit process 

 
 

Figure 7-20 | Terminal S - Backup firmware process 

 

 

• Push and hold for 1-2 seconds the POWER button to restart the amplifier and enter STANDBY 

mode. 

You can check the current firmware version in the amplifier's menu FAULT LOG (see Section 

5.5 Menu FAULTS LOG); 

 

• Push the POWER button to turn off the amplifier (back to low energy STANDBY mode); 

 

• Switch off the amplifier via Main Power Rocker Switch (see Figure 2-4 | Rear panel - 

Connections, Pos. 1); Make sure the Main Power Rocker Switch is in OFF position; 

 

• Pull the line (mains) plug out of the outlet; 

 

• Disconnect "USB to RS-232" converter or RS-232 cable; 

 

• Follow the instructions in Section 2.4 Connections to re-connect the amplifier to your station. 
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7.5.4. Troubleshooting 

 

Sometimes the procedure for Firmware Update/Backup is unsuccessful. 

 

A. Error Timeout when using Terminal S software  

If you see an error message related to Timeout, please check: 

• Latency Timer parameter as describer in Section 7.5.3 Firmware Update Procedure   

(STEP 1 – RS-232 Interface Settings on your PC); 

 

Figure 7-21 | Terminal S - Error Timeout 

 

 
 

Figure 7-21 | Terminal S - Error Timeout 

 

 

• If using a PC with a built-in RS-232 port: 

- Check Receive/Transit buffer parameters as described in Section 7.5.3 Firmware 

Update Procedure  (STEP 1 – RS-232 Interface Settings on your PC); 

- Check the used connection cable. See Table 7-2 | RS-232 connection cable wiring for 

correct cabling; 

 

• Command timeout parameter as describer in Section 7.5.3 Firmware Update Procedure   

(STEP 3 – Using Terminal S software for Firmware Update). 
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The other possible reasons for Timeout error could be, for example: 

• Windows Device Manager -> USB Serial Converter Properties -> Advanced 

Below are shown the recommended settings (VCP = Virtual Com Port):   

 

Figure 7-22 | Windows Device Manager - Load VCP 

 

 

Figure 7-22 | Windows Device Manager - Load VCP 
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• Windows Device Manager -> USB Serial Converter Properties -> Power Management 

Below are shown the recommended settings:   

 

Figure 7-23 | Windows Device Manager - Power Management 

 

 

Figure 7-23 | Windows Device Manager - Power Management 
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• Windows Power plan 

Below are shown the recommended settings:   

 

Figure 7-24 | Windows Control Panel - Power plan 

 

 

Figure 7-24 | Windows Control Panel - Power plan 
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B. If, for some reason (mostly human error), the Firmware Update/Backup process is interrupted, the 

following scenarios are possible: 

 

• The amplifier is in STANDBY mode (the monitor shows the user interface) but nothing 

happens when you press the Terminal S buttons. 

Solution: 

- Click on the Disconnect icon (two separated plugs) to disconnect from the amplifier; 

- Click on the File -> Quit from the menu bar to close Terminal S; 

- Push and hold for 1-2 seconds the POWER button to shut down the amplifier; 

- Power up the amplifier again; 

- Start Terminal S; 

- Start the Firmware Update procedure from the beginning. 

 

• The amplifier's monitor is black/no image (BOOTLOADER mode) but nothing happens when 

you press the Terminal S buttons. 

Solution: 

- Click on the Disconnect icon (two separated plugs) to disconnect from the amplifier; 

- Click on the File -> Quit from the menu bar to close Terminal S; 

- Push and hold for 1-2 seconds the POWER button to shut down the amplifier; 

- Power up the amplifier again; 

o If the amplifier starts normal and goes to STB mode, then: 

▪ Start the Terminal S and continue with the Firmware Update 

procedure from the beginning; 

o If the amplifier starts with a black monitor (BOOTLOADER mode), then start 

the Terminal S and change Serial port settings to 38400, 8, None, 1; 

▪ Connect to the amplifier by clicking on the Connect icon (two 

connected plugs); 

▪ Click on the Firmware Upload/Download icon (two arrows in 

opposite directions) to activate the bootloader. A bootloader menu 

should now appear in the text box; 

▪ Continue with the Firmware Update procedure as usual. 

 

 

If the problem persists, contact your dealer (see Section 1.9 Owner Assistance). 

 

 

 

 



User's Manual | ACOM 700S | 1.8-54 MHz Linear Amplifier  

April 2024 S e c t i o n  SPECIFICATIONS | Page 81 of 92 

 

8. SPECIFICATIONS 
 

8.1. Parameters 

 

a) Standard Frequency Coverage 

1.800 - 2.000 MHz (160 m band) 

3.500 - 4.000 MHz (80 m band) 

5.250 - 5.450 MHz (60 m band)* 

7.000 - 7.300 MHz (40 m band) 

10.100 - 10.150 MHz (30 m band) 

14.000 - 14.350 MHz (20 m band) 

18.068 - 18.168 MHz (17 m band) 

21.000 - 21.450 MHz (15 m band) 

24.890 - 24.990 MHz  (12 m band) 

28.000 - 29.700 MHz (10 m band) 

50.000 - 54.000 MHz (6 m band)* 

 

 

*  Please, refer the applicable regional band plans and laws for specific allocations and 

limitations. 

In specific business cases, extensions or changes of the frequency coverage can be 

discussed, but this must be agreed upon before ordering. In any case, this is not the 

producer's obligation and can not be against local rules and laws. 

 

 

b) Rated Output Power 

• 700 W ±0.5 dB, PEP or continuous carrier; 

 

c) Intermodulation Distortions (IMD3) 

• Better than 31 dB below the rated PEP; 

 

d) Harmonic and Parasitic Emissions Output Suppression 

• Better than 60 dB (65 dB typically); 

 

e) Input and Output Impedances 

• Nominal value: 50 Ohm unbalanced, UHF (SO-239) type connectors; 

• Input circuit: Broadband, SWR below 1.2:1 (1.1:1 typically), 1.8-54 MHz continuous 

range without retuning or switching; 

• RF bypass path: SWR - below 1.1:1, 1.8-54 MHz; 

• Acceptable SWR at the output load (the antenna): up to 3:1 with proportional power 

reduction and up to 1.5:1 for full output power; 
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f) RF power gain 

• 14 dB ±1 dB (typically 27 W for 700 W output power); 

 

g) Mains Power Supply Voltage 

• 100-240 VAC (see Section 7.3 Fuse Replacement for correct fuse rating and mains voltage 

range selections); 

 

h) Mains Power Consumption at Full Output Power 

• 1350 VA or less with power factor of 0.95 or higher; 

 

i) Mains Power Consumption in Low Energy (Waiting) Mode 

• Less than 1 VA; 

 

j) Complies with CE safety and electromagnetic compatibility requirements, as well as with the 

US Federal Communications Commission (FCC) regulations; 

 

k) Size & Weight (operating, excluding connected cables and opened tilt foot bar) 

• WxDxH: 326x388x155 mm, 11.6 kg (12.9x15.3x6.1 inches, 25.6 lbs.); 

 

l) Operating Environments 

• Temperature range: -10 to +40 degrees Celsius (14 oF to 104 oF); 

• Relative air humidity: up to 95% @ 35 degrees Celsius (95 oF); 

• Height above sea level: up to 3050 m (10000 ft) without output deterioration. 

 

 

8.2. Functions 

 

a) Receive / transmit control 

• KEY IN input - Phono RCA connector. Voltage applied to the transceiver keying output - 

up to +12 V; Current flown to the transceiver keying output - up to 6 mA; 

• KEY OUT output - Phono RCA connector. Output resistance: not more than 120 Ohm; 

Maximum safe input voltage from the transceiver +50 V; maximum safe current flawn by 

the transceiver: 20 mA; 

• Minimum dead time, necessary for safe amplifier switching over from receive to 

transmit: 10 ms between the transmit request on the KEY IN input and the RF drive on 

the RF INPUT connector. 

 

b) Protections 

• Inrush power-on current is limited 

• PA drain current 

• Overheating 

• T/R sequencing 
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• Antenna relay contacts against hot switching 

• Reflected power 

• Overdrive. 

 

c) Frequency control by either internal frequency counter or directly by CAT from the 

transceiver, as well as via front panel buttons 

 

d) Remote control through ACOM eBox Ethernet Remote Control device or via RS-232 interface 

 

e) Remote POWER ON by DSR/DTR and CTS/RTS lines on the RS-232 port or by ACOM eBox 

Ethernet Remote Control device 

 

f) Remote POWER ON / TURN OFF by DC voltage impulse or continuous DC voltage on CAT/AUX 

port ON_RMT input 

 

g) Protection against relay switching under RF power (hot switching). 
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8.3. Regulatory Requirements 

 

a) European conformity 

 

   

 CE mark (Conformitè Europëenne) 

This symbol explains that "CE" marked ACOM product meets the 

essential requirements of the Radio Equipment Directive, 

2014/53/EU, and the restriction of the use of certain hazardous 

substances in electrical and electronic equipment Directive, 

2011/65/EU. 

 

 

b) US Federal Communications Commission (FCC) regulations  

 

FCC ID: 2AJXZ700S  FCC ID number 

The FCC ID number explains that market ACOM product 

complies with the US Federal Communications Commission (FCC) 

regulations. 

 

 

The FCC ID number can be checked at 

www.fcc.gov/oet/ea/fccid. 

 

FCC ID numbers consists of two elements: 

 - А grantee code (for example 2AJXZ), and 

 - Аn equipment product code (for example 700S). 

 

 

c) RF Exposure Information 

 

 WARNING 

Using the ACOM 700S amplifier, antennas must be operated at certain minimum 

distance between the radiator and any person's body. 

 

 

This unit (ACOM 700S amplifier) complies with the FCC RF Exposure limits for an 

uncontrolled environment. 

 

 

To comply with CFR Title 47 Part 97.13(C) and the Guidelines and Limits for Human 

Exposure to RF electromagnetic fields adopted by the FCC, you should evaluate your 

Radio Station Facilities as described in OET BULLETIN 65 plus SUPPLEMENT B - Additional 

Information for Amateur Radio Stations. 

http://www.fcc.gov/oet/ea/fccid
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OET BULLETIN 65 plus SUPPLEMENT B can be found at: 

 • https://www.fcc.gov/bureaus/oet/info/documents/bulletins/oet65/oet65.pdf; 

 • https://www.fcc.gov/bureaus/oet/info/documents/bulletins/oet65/oet65b.pdf. 

 

 

In addition to the above guidelines, please, see Section 3.6.f) Elimination of electromagnetic compatibility 

(EMC) problems. 

 

 

https://www.fcc.gov/bureaus/oet/info/documents/bulletins/oet65/oet65.pdf
https://www.fcc.gov/bureaus/oet/info/documents/bulletins/oet65/oet65b.pdf
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8.4. Storage and Shipment 

 

8.4.1. Storage Environment 

 

The amplifier may be kept packed in a dry, ventilated, and unheated location (with no chemically active 

substances such as acids or alkalis) within the following environment ranges: 

• Temperature range: -40 to +70 degrees Celsius (-40 oF to 158 oF); 

• Humidity: up to 75% @ +35 degrees Celsius (95 oF). 

 

8.4.2. Shipping Size and Weight 

 

• WxDxH: Approx. 535x595x375 mm, 16.0 kg (21.1x23.5x14.8 inches, 35.3 lbs.). 

 

 

Please, contact ACOM (see 1.9 Owner Assistance) for shipment details. 

 

 

Figure 8-1 | Packaging cardboard box 

 
 

Figure 8-1 | Packaging cardboard box 

 

 

8.4.3. Transportation 

 

All types of transportation may be used, including storage in an aircraft baggage compartment at up to 

12000 meters (40000 ft) above sea level. 

 



User's Manual | ACOM 700S | 1.8-54 MHz Linear Amplifier  

April 2024 S e c t i o n  SPECIFICATIONS | Page 87 of 92 

 

8.4.4. Returning to the Service Provider 

 

This document section contains the general information on packing and shipping an amplifier for 

diagnostics and repair. 

 

 

NOTICE 

Should it be necessary to ship the amplifier, use the original packing as described below. 

 

 

NOTICE 

Before shipping the amplifier, you should contact your local dealer first. 

Your dealer can have a specific shipment requirement, e.g., a different shipping address. 

It is the sole customer's responsibility to ensure the commutator and all accessories are 

properly packaged to avoid any shipping damage. 

 

 

If transporting for diagnostics and repair, you may not need to ship some cables or 

accessories. Please, consult with your dealer first. 
 

 

Prepare the amplifier for shipping as described below: 

• Switch off the amplifier via Main Power Rocker Switch (see Figure 2-4 | Rear panel - Connections, 

Pos. 1); Make sure the Main Power Rocker Switch is in OFF position; 

• Pull the amplifier's line (mains) plug out of the outlet; 

• Do not disconnect GND connection; 

• Disconnect all cables (except GND connection) from the rear panel of the amplifier; 

 

 

 DANGER 

Remove the GND connection last (see Figure 2-4 | Rear panel - Connections, Pos. (a)) and 

wait 30 minutes for safety.  

 

 

• Pack the amplifier in its original cardboard carton. Please, follow the instructions in section 

2.1 Unpacking and Initial Inspection but in reverse order; 

• Seal the amplifier carton with heavy duty, 2-inch-wide self-adhesive tape; 

• Finally, the external strapping needs to be added over the amplifier carton. Either plastic or 

metal bands can be used; 

• Now, the amplifier is ready for shipment. 
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Basic shipping insurance is provided by the customer when sending in an amplifier - you 

can verify the amount covered by the shipping company by looking on their website. If 

you are shipping the amplifier, full/upgraded coverage is available as a suggested 

option. 

 

 

For alternative shipping instructions, please, contact your local dealer. 

 

 

 

8.5. Information on Disposing and Recycling of Old Electrical and Electronic Equipment 

 

The information in this section is applicable for countries that have adopted separate 

waste collection systems. 
 

 

ACOM products cannot be disposed as household waste. 

 

 

   

 

Waste electricals 

 

This symbol (crossed-out wheeled bin) explains that you should 

not place the electrical item in the general waste.  

 

 

   

 Waste electricals 

 

This symbol (three green arrows going in a triangle with electrical 

plug in the center) means that according to local laws and 

regulations this product should be sent for recycling.  

 

 

 

Old electrical and electronic equipment and batteries should be recycled at a facility capable of handling 

these items and their waste byproducts. 

 

Contact your local authority for details in locating a recycle facility nearest to you. 

 

Proper recycling and waste disposal will help conserve resources whilst preventing detrimental effects on 

our health and the environment. 

 

 

Ultimate disposal of this product should be handled according to all national laws and 

regulations. 
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This manual is for electronic distribution mainly. 

If you have it on paper and you no longer need it, please, recycle it! 

 

The latest versions of our User's Manuals are available at 

www.acom-bg.com 

 

http://www.acom-bg.com/


Dealer/Partner's address:

www.acom-bg.com
ACOM and the ACOM logo are registered trademarks of ACOM Ltd. in many countries, 

including the EU and United States.  I  The used images are illustrative only.
Subject to change without notice.  I  Printed in Bulgaria. 
All rights reserved.  I  Design and content by ACOM Ltd.

ACOM 700S User's Manual  I  Fourth Edition, Revision 02  I  April 2024.

 ACOM Ltd.

 Bulgaria  |  Bozhurishte 2227

 Sofia-Bozhurishte Industrial Park  |  6 Valeri Petrov Str.

 GPS coordinates:  42.748616о  |  23.209801о

 support@acom-bg.com
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